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Welcome to ClaroRead 
ClaroRead is a simple, easy-to-use, flexible application that helps you to read 
and write using your computer. While it is closely integrated with Microsoft 
Word, Outlook, and PowerPoint to help you work with text, it can also help you 
work with web pages, PDFs, and more. 

 

The simple ClaroRead toolbar contains a wide range of functionality to help 
with reading and writing, including: 

• Text-to-speech (TTS) 

Read practically any text from your screen, using a range of high-quality 
voices. This includes reading out text in menus, buttons, and tooltips. 
ClaroRead can instantly read out text that you select using your mouse, as 
well as reading back text as you type it. 

Configurable word-by-word highlighting helps you to follow text as it is read 
aloud. ClaroRead’s high quality voices include many languages and accents, 
male and female. 

ClaroRead can even save whole documents to audio so you can listen to 
them later. 

• Visual assistance 

Easily adjust font size, typeface, and spacing in Microsoft Word. ClaroRead 
also includes utilities for tinting and masking your screen. 

• Writing tools 

Check spelling, including phonetic misspellings and homophones, with a 
speaking dictionary to help you choose the right words. ClaroRead also has 
advanced word prediction that can be used with any application. 
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• Scanning (OCR) 

Scan documents from paper, file (including PDF), or screen, using OCR to 
make text accessible. OCR, or optical character recognition, is the 
conversion of pictures of text (for example, a photo of a document) into 
computerised text that can be copied, edited, and so on. 

• Speech recognition 

Write text by speaking into your microphone. 

ClaroRead works with any application on your computer. You can place the 
highly visible ClaroRead toolbar anywhere on your screen, dock it to the top of 
the screen, or lock it to the currently active window. You can easily choose 
which buttons are shown on the toolbar, as well as changing its size and 
display style. 

ClaroRead SE 

ClaroRead SE is a simplified version of ClaroRead. It is designed for exams so 
does not include features such as proofing and advanced scanning. 

 

For more details, see the ClaroRead SE help system. 

https://www.clarosoftware.com/help/help_files/manuals.php?product=claroreadse&os=windows
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The ClaroRead Toolbar 
The ClaroRead toolbar lets you use ClaroRead's powerful features at any time 
without getting in your way. The toolbar is kept simple by default, containing 
buttons for ClaroRead’s most used features: 

 

You can add buttons for more features. The full toolbar contains the following 
buttons: 

 

The above images show the toolbar in its default display style, or ‘skin’. This is 
the Classic skin, a friendly high-colour style designed for maximum usability. 

Two other skins are available: 

• Professional – this skin uses colour to help you distinguish between the 
different buttons. 

 

• Modern – a clear and simple skin that won’t distract you from your other 
applications. 
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All three skins have “dark mode” equivalents. If you use Windows with a dark 
theme (or specify dark mode for your apps), the ClaroRead toolbar uses light 
icons on a dark background: 

 

Several toolbar buttons are hidden by default. We recommend that you hide 
buttons that you do not use regularly, to make the toolbar smaller and easier to 
use. 

You can show or hide buttons in View Settings, as well as choosing your 
preferred skin. 
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ClaroRead Toolbar Buttons 
The ClaroRead toolbar can have the following buttons: 

Play button 

Click the Play button (or press F7) to start ClaroRead speaking:  

• In some applications, including Microsoft Word, PowerPoint, Outlook, 
and Adobe Acrobat, ClaroRead starts reading aloud from the cursor 
position onwards. 

• In other applications, if text if selected, ClaroRead reads aloud the 
selected text. 

• In other applications, if no text is selected, ClaroRead reads aloud the 
contents of the Windows clipboard. 

ClaroRead also has mechanisms for reading text aloud automatically, 
that is, without clicking Play. For example, it can read aloud any text that 
you select with the mouse, or read words aloud as you type them. 

See Speech Features. 

Stop button 

Click the Stop button to halt ClaroRead speaking. You can also click the 
mouse (anywhere, it does not matter) or press the Ctrl or F8 keys to 
stop ClaroRead speaking. 

Dictate button 

Click the Dictate button to access speech recognition, enabling you to 
dictate text rather than using your keyboard. 

If you have Nuance’s Dragon software installed, ClaroRead uses that for 
speech recognition. Otherwise, it uses Windows voice typing.  

See Dictate Features. 
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Font button 

The Font button allows you to quickly change the font of a whole 
Microsoft Word document (or a selected portion of it) to one of three 
more readable and popular fonts – Comic Sans MS, Trebuchet MS, or 
Microsoft Sans Serif. You can also easily increase or decrease font size, 
or change text colour.  

See Font Features. 

This button is hidden by default. 

Spacing button 

The Spacing button allows you to quickly change the spacing between 
text characters, lines and paragraphs in a Microsoft Word document.  

See Spacing Features. 

This button appears with the Font button and is hidden by default. 

Check button 

Click the Check button (or press F9) to start ClaroRead’s spelling 
checker. ClaroRead’s spelling checker is tightly integrated with 
Microsoft Word, offering suggested words, synonyms, and dictionary 
definitions to help you choose the correct spelling. It also works in most 
other applications where you need to enter text.  

See Check Features. 

Homophones button 

Click the Homophones button (or press F10) to start ClaroRead’s 
homophone checker. Homophones are words that sound alike but are 
different in meaning, for example blew and blue, and can be a problem 
for many people. ClaroRead can identify homophones in your text and 
present you with suggestions that sound similar.  

See Homophone Features. 
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Predict button 

The Predict button enables word prediction, which can be a very useful 
tool for certain writing styles. The ClaroRead word prediction feature 
contains the most frequently used English words. You can also train 
prediction to use your own vocabulary either from a document or 
learning from your typing.  

See Word Prediction Features. 

This button is hidden by default. 

Save button 

Click the Save button to convert text into an audio file saved on your 
computer. You can save text from Microsoft Word, PowerPoint, Adobe 
Acrobat, or the clipboard.  

See Save Feature. 

Extras button 

This provides a handy link to start selected other applications and 
utilities, including ScreenRuler (screen tinting and masking), 
ClaroCapture (a study skills tool to help you gather information), 
ClaroPDF (a speech-enabled PDF reader), and Speaking Calculator. 

See ClaroRead Extras. 
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Scan button 

The Scan button contains the following scanning options: 

• Scan from Paper – scans a paper document, with the output sent 
directly into a Word document or saved to file. 

• Scan from PDF/File – scans inaccessible text, such as a non-textual 
PDF or an image file, and converts it into standard text, saved to file. 

• Scan from screen – scans text from the screen, even if that text 
cannot be selected normally, and sends it to the clipboard as 
standard text. 

ClaroRead uses the powerful OmniPage optical character recognition 
(OCR) technology to take any text, even if it is not encoded as words 
and characters, and convert it into text that can be used in your 
documents and read out by ClaroRead. 

See Scanning Features. 

Settings button 

The Settings button opens the Settings window, enabling you to 
change all the main ClaroRead options and settings. The Settings 
window contains pages for Speech, View, Prediction, Check, and Scan 
settings. 

See ClaroRead Settings. 

Help button 

Click the Help button (or press F12) to open the ClaroRead help system. 
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Undock button 

When the ClaroRead toolbar is docked to the top of your screen, click 
the Undock button to return it to its floating state.  

See Moving, Docking, and Hiding the ClaroRead Toolbar. 

Close button 

Click the Close button to close ClaroRead completely.  

Note that you can hide the ClaroRead toolbar temporarily using its 
Minimise button or your keyboard’s Pause key.  

See Moving, Docking, and Hiding the ClaroRead Toolbar. 
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Moving, Docking, and Hiding the 
ClaroRead Toolbar 
You can use the ClaroRead toolbar in three modes: 

• Floating on top of your desktop (default) 

• Locked to the active window 

• Docked to the top of the screen 

You can also hide the toolbar by minimising it to the Windows taskbar. Many of 
ClaroRead’s features continue to work while the toolbar is hidden. 
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Floating toolbar 
By default the ClaroRead toolbar behaves like a normal window, which floats 
on top of your desktop so you can always use it no matter what you are doing. 
You can use the title bar to drag the toolbar to a suitable place on your 
desktop. 

The toolbar behaves like this when the Lock toolbar to active window 
checkbox is unchecked in View Settings. 
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Locking the toolbar to the active window 
You can lock the ClaroRead toolbar to the currently active window. The toolbar 
will move automatically as you switch between different applications, always 
locked to the top right of the active application's window. 

To enable this behaviour, select the Lock toolbar to active window checkbox 
in View Settings. 

 

 

When using this mode, we recommend that you make the ClaroRead toolbar as 
small as possible so that it does not block your application's menu or toolbar. 
The above example shows the toolbar set to medium size with captions turned 
off. It also uses a colourful skin, which helps the toolbar to stand out from the 
application behind it. 
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Docking the toolbar to the top of the screen 
If the ClaroRead toolbar is floating, you can dock it to make a toolbar all across 
the top of your desktop. Click the toolbar title bar and drag it to the top of the 
screen. Release the toolbar and it locks itself to the top of the screen.  

When docked, the toolbar always remains in the same place, where it will not 
obscure your applications’ buttons or menus. 

 

Click the Undock button  to return the toolbar to its normal floating state. 
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Minimising or hiding the toolbar 
You can hide the ClaroRead toolbar completely by minimising it. Many of the 
speech and prediction features will still work, such as speaking when you 
select text with the mouse or hover over text in a web page. 

The simplest way to do this is to press your keyboard’s Pause key, which will 
make the toolbar appear and disappear. You can also use the normal Minimise 
button on the floating toolbar: 

 

ClaroRead minimises to the Windows taskbar, like many other applications. 
Click ClaroRead’s taskbar button to show the toolbar again. 
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Speech Features 
ClaroRead’s ability to make the computer talk is one of its key innovative 
features. ClaroRead uses high-quality synthesised voices, such as RealSpeak 
or Vocalizer voices from Nuance (formerly Scansoft). ClaroRead will also work 
with any other text to speech synthesiser voices that may be installed on your 
computer so long as they comply with the SAPI5 standard. 

ClaroRead offers a range of different speech features, which are described 
below. Some speech features depend on the application that you are using. For 
example, you can simply position the cursor in a Microsoft Word document and 
click Play, whereas in Windows Notepad you need to select text with your 
mouse first. 

Generally, you can control ClaroRead’s speech using the toolbar’s 
Play and Stop buttons. Alternatively, you can press F7 (Play) and 
F8 (Stop). ClaroRead also stops speaking when you press the 
Ctrl key or the Spacebar. 

ClaroRead’s speech is highly configurable. You can enable or disable individual 
speech features, or change the way they behave.  

See Speech Settings and Advanced Speech Settings.  

Click and play 

In some applications, you can position the cursor and click Play. ClaroRead 
starts reading aloud from the cursor position onwards, highlighting text as it 
reads it. These applications include Microsoft Word, PowerPoint, Outlook, 
LibreOffice Writer, and Adobe Acrobat. 

If you hold down Shift and click Play (or press Shift+F7) in these applications, 
ClaroRead reads only a single sentence. 

In most other applications, you must select the text you want to read before 
clicking Play. 
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Speak from the clipboard 

For applications that do not support speaking from the cursor, clicking Play 
without anything selected results in ClaroRead reading aloud the text that is 
currently stored in the Windows clipboard. 

To use this feature quickly, you can select text, press Ctrl+C to copy it to the 
clipboard, and then press F7 to speak it using ClaroRead. 

Speak when mouse selects 

ClaroRead automatically reads aloud any text that you select with the mouse. 
This works in most applications and is often the most convenient way to speak 
text. 

Note: This speech feature only works when you select text “normally” using 
your mouse – that is, by clicking your left mouse button, holding it down, and 
dragging the cursor to include the text that you want to read.  

ClaroRead will not read out text that you select by double-clicking, or by using 
your keyboard. 

Speak word on Ctrl+hover 

If you hold down the Ctrl key and hover the mouse pointer over any word on 
your screen, ClaroRead reads that word aloud. This works for toolbar buttons, 
menu items, hyperlinks, and so on. 

Speak under mouse 

ClaroRead can automatically read any text that you hover your mouse pointer 
over. This includes paragraphs, hyperlinks, buttons, and alternative text for 
pictures. 

By default, this feature is available in only a few selected applications, including 
ClaroIdeas. While you can configure ClaroRead to speak under the mouse for 
all applications, this can be distracting. 
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Speak when the cursor moves 

ClaroRead can automatically read text aloud as you move the cursor through it 
using your keyboard’s arrow keys: 

• Pressing Right or Left moves the cursor to the next or previous character 
and ClaroRead reads out that character. 

• Pressing Ctrl+Right or Ctrl+Left moves the cursor to the next or previous 
word and ClaroRead reads out that word. 

• Pressing Down or Up moves the cursor to the next or previous line and 
ClaroRead reads out that entire line. 

• Pressing Ctrl+Down or Ctrl+Up moves the cursor to the next or previous 
paragraph and ClaroRead reads out that whole paragraph. 

You can use these commands repeatedly, for example pressing the Down 
arrow repeatedly to read through a document. 

You can configure ClaroRead to speak phonetic letter sounds rather than 
characters when you press the Right and Left arrow keys. 

This speech feature is disabled by default. 

Echo text as you type 

ClaroRead can automatically read aloud every word that you type, immediately 
after you type it. This is great for confirming that you have typed the word that 
you intended, but note that you may type quicker than ClaroRead can speak! 

You can configure ClaroRead to echo sentences, words, or individual 
characters. 

ClaroRead can either speak each letter’s name as you type (like “ay” for 
“apple”) or speak each letter’s sound (like “ah” for “apple”). If you’re a beginning 
learner working on your phonics, the letter sounds may be most useful.  

This speech feature is disabled by default. 
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Echo Dragon voice input 

If you use Nuance’s Dragon speech recognition software, ClaroRead can echo 
each word or phrase that Dragon recognises. This gives you confidence that 
Dragon has correctly recognised what you said, or draws your attention to any 
misrecognitions. 

See Echoing Dragon Voice Input. 

This speech feature is disabled by default. 

Skip references 

When reading text aloud, ClaroRead automatically skips anything that looks like 
a reference, such as journal details in parentheses. This makes it easier for you 
to focus on the main text, without references to break up its flow. 

If you prefer to have all references read aloud, this speech feature can be 
disabled in ClaroRead’s Speech Settings. 
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Making Word, PowerPoint, and Outlook Speak 
Microsoft Word, PowerPoint, and Outlook support a wide range of ClaroRead 
speech features: 

• Click and play (with text highlighting) 

• Speak when mouse selects (no highlighting) 

• Speak word on Ctrl+hover 

• Speak under mouse (if enabled) 

• Speak when the cursor moves (if enabled) 

• Echo text as you type (if enabled) 

Note: ClaroRead temporarily changes text colour and background when 
highlighting text. For some documents this may affect existing formatting. 

Play On mode 

If you position your cursor in a Word document and hold down Ctrl 
while you click Play (or press Ctrl+F7), ClaroRead enters Play On mode 
and the Play button changes appearance. 

ClaroRead continues reading the contents of your document until you click 
Stop, even if you switch to another application. You can even edit the original 
document while ClaroRead is reading it out. 

Keyboard shortcut toggle 

ClaroRead uses its own keyboard shortcuts, which can conflict with Word, 
PowerPoint, and Outlook’s own shortcuts. For example, F9 opens ClaroRead’s 
Check window whereas you might want to use Word’s F9 shortcut to update 
document fields. 

To use a Word, PowerPoint, or Outlook keyboard shortcut, press F6 to switch 
between ClaroRead’s shortcuts and the application’s. To switch back, click the 
ClaroRead toolbar and then press F6 again. 
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Making presentations speak 

If you click Play (or press F7) while viewing a presentation in PowerPoint’s Slide 
Show mode, ClaroRead will start reading aloud, with text highlighting, from the 
start of the current slide.  

ClaroRead continues reading, progressing through your slide deck until you 
click Stop or interrupt the presentation. 

Other word processors 

Other word processors, such as Apache OpenOffice and LibreOffice Writer, 
support some of the same ClaroRead speech features as Word. These may 
include “click and play” and the Play On mode. 
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Making PDF Documents Speak 
Adobe Acrobat and Adobe Acrobat Reader support a similar range of 
ClaroRead speech features to Word: 

• Click and play (with text highlighting) 

• Speak when mouse selects (no highlighting) 

• Speak word on Ctrl+hover 

• Speak under mouse (if enabled) 

Unlike Word, you cannot use “speak when the cursor moves”, echo text, or Play 
On mode in a PDF document. 

Some PDFs are inaccessible, that is, they contain images of text rather than 
characters and words. The above speech features will not work for 
inaccessible PDFs – instead, you can use ClaroRead’s scanning features to 
convert them into accessible PDFs, with text that can be read aloud, copied 
into other documents, and so on. 

See Scanning Features and Making Accessible PDFs. 

Note: Even accessible PDF files are very complex, which can sometimes cause 
problems for ClaroRead (and all assistive technology). If you have problems 
with a PDF, use ClaroRead’s scanning feature to create a new PDF from it – this 
will usually work better than the original PDF.  
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Making Web Pages Speak 
You can use the ClaroRead toolbar with the Google Chrome web browser. 
Speech features supported by Chrome include: 

• Click and play (with text highlighting) 

• Speak when mouse selects (no highlighting) 

• Speak word on Ctrl+hover 

• Speak under mouse (if enabled) 

• Echo text as you type (if enabled) 

These speech features work whether you are browsing the web or using 
feature rich web apps such as Gmail, Facebook, Google Docs, and Microsoft 
Word Online. 

Note that you can also use ClaroRead’s spelling checker, word prediction, and 
so on when you are writing text on web sites or web apps. 

ClaroRead Chrome Extension 

To use ClaroRead with Chrome, you need to have the ClaroRead Chrome 
extension installed. This is usually installed automatically with ClaroRead, in 

which case you will see its   icon in the extensions area, at the top right of 
your Chrome window: 

 

If you do not see the  icon, click the Extensions icon  to see if ClaroRead 
Chrome has been installed but is not visible. 

If ClaroRead Chrome has not been installed, you can find it in the Chrome Web 
Store. 

https://chrome.google.com/webstore/detail/claroread-chrome/ifgehbglgmidafhhdcopacejknmcmhcd?hl=en
https://chrome.google.com/webstore/detail/claroread-chrome/ifgehbglgmidafhhdcopacejknmcmhcd?hl=en
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ClaroRead Chrome often activates automatically when you load a web page, so 
you can simply use the standard ClaroRead toolbar to read text from that page. 

If this does not happen automatically, however, you may need to click . You 
may also be prompted to reload the page. 

Using the ClaroRead Chrome Extension without ClaroRead 

If ClaroRead is not running, clicking  opens the ClaroRead Chrome 
extension’s own toolbar: 

 

This toolbar gives you access to many of ClaroRead’s features in Chrome, 
including dictation, word prediction, and screen tinting. It only works within the 
Chrome window.  

Note that some features are hidden by default, to keep the toolbar simple and 
unobtrusive. You can toggle buttons on and off from the View tab of ClaroRead 
Chrome’s Settings screen. 

To use premium features, such as scan from screen and the spelling checker, 
you may need to sign into your Claro Account in either ClaroRead Chrome’s 
settings or the Chrome browser itself. 

ClaroRead Edge Extension 

If you prefer to use Microsoft Edge as your web browser, you can install the 
ClaroRead Edge extension from the Edge Add-ons store. 

ClaroRead Edge has similar functionality to ClaroRead Chrome. Unlike 
ClaroRead Chrome, however, it is not currently integrated with the main 
ClaroRead toolbar – that is, you must use ClaroRead Edge’s own toolbar: 

 

https://microsoftedge.microsoft.com/addons/detail/claroread-edge/ihfpigepfgecfldfdjmcoaannmgjgche
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Making Other Applications Speak 
You can make almost any application speak using the following ClaroRead 
speech features: 

• Click and play (with text selected before you click Play) 

• Speak when mouse selects 

• Speak word on Ctrl+hover 

• Speak under mouse (if enabled) 

• Speak from the clipboard 

Many applications that support text entry will also support one or more of the 
following speech features: 

• Speak when the cursor moves (if enabled) 

• Echo text as you type (if enabled) 

For example, ClaroRead will read out text that you select in Microsoft Excel. In 
Windows Notepad, it will also echo your typing, as well as speaking as you 
move the cursor. 

Experiment with the applications you use regularly to find the best way to use 
them with ClaroRead. Don’t forget that you can also configure ClaroRead’s 
speech settings to suit the way you work. 

Muting ClaroRead 
ClaroRead may speak a lot when you do not need it, which can be distracting. 
You can mute ClaroRead temporarily by pressing Ctrl+F8. 

Press Ctrl+F8 again to unmute ClaroRead. 
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Dictate Features 
Click the Dictate button to access speech recognition, enabling you to 
dictate text rather than using your keyboard.  

ClaroRead uses the following speech recognition systems:  

• Dragon speech recognition 

If you have Nuance’s Dragon software installed, the Dictate button controls 
Dragon’s microphone. You can use the full range of Dragon’s functionality to 
dictate and edit text without opening Dragon’s own toolbar. 

• Windows voice typing 

If you do not have Dragon installed, the Dictate button opens the Windows 
Voice Typing toolbar. You can use Windows voice typing to dictate text and 
perform basic editing. 

Both these speech recognition systems provide a complete end-to-end 
solution for users who have difficulty using their keyboard and screen – you 
can dictate text using Dragon or Windows voice typing, and then use 
ClaroRead to help you check and edit it. 
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Dictating with Dragon 
ClaroRead is often installed alongside Nuance’s Dragon speech recognition 
software (formerly Dragon NaturallySpeaking). If so, you can use the ClaroRead 
toolbar’s Dictate button to dictate with Dragon without having to open 
Dragon’s own toolbar. 

The Dictate button changes to reflect the current status of Dragon’s 
microphone, and can be used to turn the microphone on or off:  

Microphone Off 

Click Dictate to turn on Dragon’s microphone.  

While the microphone is off, it will not respond to any voice 
commands. 

Microphone On 

Click Dictate or say “microphone off” to turn off Dragon’s 
microphone.  

You can also say “go to sleep” to put the microphone to sleep. 

Microphone Asleep 

Say “wake up” to turn on Dragon’s microphone and start 
dictating. 

If you click Dictate or say “microphone off”, the microphone 
turns off completely.  

When the microphone is turned on, you can use the full range of Dragon’s voice 
commands. As well as dictating and editing text, you can use your voice to 
control Windows, browse the web, and work in applications including Microsoft 
Office. 

For more details, see your Dragon documentation. 
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Echoing Dragon Voice Input 

ClaroRead can “echo” each word or phrase that Dragon recognises. This helps 
provide user confidence, as well as accuracy of dictation, by confirming that 
Dragon has recognised your speech correctly. If your speech has not been 
recognised correctly, the echo helps to draw your attention to the 
misrecognition. 

You need to configure both Dragon and ClaroRead to use this feature: 

• In Dragon, turn on the Results Box  

From the Dragon toolbar, click Tools > Options and then open the 
Appearance tab. Select the Show preliminary results checkbox.  

We recommend that you also set Auto-hide delay to Never hide. 

• In ClaroRead, enable the echo feature 

Open ClaroRead’s Advanced Speech Settings and select the Echo Dragon 
voice input checkbox. 

Now, when you dictate text, Dragon shows what it has recognised in a Results 
Box, which ClaroRead then reads aloud. 

Note: This feature works best with a headset or headphones – otherwise, 
Dragon may recognise ClaroRead’s speech and go into a loop, repeating the 
original dictation endlessly. 
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Dictating with Windows Voice Typing 
If you do not have Dragon installed, ClaroRead uses Windows voice typing.  

Click Dictate to open the Windows Voice Typing toolbar, with its microphone 
turned on. Anything you dictate will be inserted at the current cursor position: 

 

If you click ClaroRead’s Dictate button while the Voice Typing toolbar is open, 
it toggles the microphone on and off. 

Note that voice typing is only available on Windows 10 or later, with different 
voice commands available for each version of the operating system. It also 
requires an internet connection. 

For more details, see Microsoft’s voice typing support page. 

Echoing Windows Voice Typing 

ClaroRead cannot echo Windows voice typing like it can for Dragon. Instead, 
you can use ClaroRead’s “echo text as you type” speech feature to echo back 
words or sentences when you press your keyboard’s Spacebar or Enter keys 
(or when you dictate “press Space” or “press Enter”). 

https://support.microsoft.com/en-gb/windows/use-voice-typing-to-talk-instead-of-type-on-your-pc-fec94565-c4bd-329d-e59a-af033fa5689f
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Font Features 
You can enable the Font button in ClaroRead’s View Settings. 

Changing font size, typeface and colour can often make text easier to 
read. When working in Microsoft Word, click ClaroRead’s Font button to 
open the following menu: 

 

Select an option to make a quick change to your document’s text.  

If you have text selected, the option will only be applied to the selected text – 
otherwise, it will be applied to the entire document. 

Note: Any changes you make using the Font menu will override or otherwise 
affect your document’s existing formatting. 

Increase Font Size 

Increases the size of the selected text (or all text in the document) by 2 points. 

If your text includes different text sizes, it will all be set to the same size – that 
is, the size of the first selected text (or the text at the cursor position) plus 2 
points. 
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Decrease Font Size 

Decreases the size of the selected text (or all text in the document) by 2 
points.  

If your text includes different text sizes, it will all be set to the same size – that 
is, the size of the first selected text (or the text at the cursor position) minus 2 
points. 

Comic Sans MS / Trebuchet MS / Microsoft Sans Serif 

Changes the font of the selected text (or all text in the document) to Comic 
Sans MS, Trebuchet MS, or Microsoft Sans Serif. 

These three fonts are available by default because many people find them 
easy to read. You can change the fonts shown in the Font menu using 
ClaroRead’s Advanced Settings Editor. 

Foreground Colour 

Changes the colour of the selected text (or all text in the document). 

When you click this option, a set of colours is displayed: 

 

Select a colour to apply it to your text. 
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Spacing Features 
You can enable the Spacing button in ClaroRead’s View Settings. 

Changing spacing and text width can make text easier to read. When 
working in Microsoft Word, click ClaroRead’s Spacing button to open 
the following menu: 

 

Select an option to make a quick change to your document’s spacing. Some 
examples of modified character and line spacing are shown below: 
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If you have text selected, the option will only be applied to the selected text – 
otherwise, it will be applied to the entire document. 

Note: Any changes you make using the Spacing menu will override or 
otherwise affect your document’s existing formatting. 

Change Character Spacing 

Expands character spacing by 1 point, then 2 points, and then 3 points. If 
clicked again, character spacing returns to normal. 

If your text includes different character spacings, it will all be set to the same 
spacing – that is, the spacing of the first selected text (or the text at the cursor 
position) plus 1 point. 

Change Line Spacing 

Changes line spacing to 1 line, then 1.5 lines, then 2 lines. If clicked again, line 
spacing returns to 1 line. 

If your text includes different line spacings, it will all be set to the same 
spacing. 

Change Paragraph Spacing 

Changes the spacing after each paragraph to zero, then 6 points, then 12 
points, then 18 points, then 24 points. If clicked again, paragraph spacing 
returns to zero. 

If your text includes different paragraph spacings, it will all be set to the same 
spacing. 

Change Text Width 

Changes the text column to a single narrow column, then two columns, and 
then back to a single wide (whole-page) column. 

This option always changes the entire document. 
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Check Features 
ClaroRead provides a single Check button (F9) to find and correct 
spelling mistakes.  

To help you make the right correction, ClaroRead’s Check window offers 
suggested words, synonyms, and dictionary definitions. It can also give short 
meanings and identify homophones. 

The Check window works in almost any application – not just word processors 
but also email clients, web browsers, and anywhere else that you need to enter 
text. Note that the procedure for checking spelling in Microsoft Word is 
different to other applications. 

In addition to the Check window, ClaroRead has a speaking dictionary tooltip 
that gives a spoken definition for any word in any application. If you have a 
multilingual system, the dictionary tooltip can also translate words quickly and 
easily. 

You can configure the behaviour of the Check window and dictionary tooltip, or 
edit ClaroRead’s list of spelling corrections.  

See Check Settings and the Advanced Settings Editor. 
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Checking Spelling in Word 
Microsoft Word has its own powerful spelling and grammar checker, which 
marks errors in your document with red and blue wavy lines. ClaroRead’s 
spelling checker is designed to work alongside Word’s functionality – you can 
already see which words need attention, so you can go straight to them and 
make corrections. 

To check spelling in Word: 

1. Position the cursor in a word and then click  (or press F9). 

ClaroRead checks the word and the Check window appears.  

If the word is incorrectly spelled, the Check window shows the Spelling tab: 

 

If the word is already spelled correctly, the Check window still appears but 
it shows the Meanings tab, enabling you to check the meaning of the word 
or find a synonym for it. Proceed to step 3. 
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2. In the Spelling tab, you can: 

• Select a suggestion or synonym (or type your own correction into the 
Word field) and then click Change. ClaroRead applies the correction and 
the Check window shows the Meanings tab for the new word. 

• Click Ignore to proceed to the next misspelled word without making a 
correction. 

• Click Close to close the Check window without making a correction. 

3. In the Meanings tab, either: 

• Select a meaning or synonym and then click Change. ClaroRead applies 
the correction and the Meanings tab updates to show details of the new 
word. 

• Click Close to close the Check window and end the spellcheck. 

Spell Check All 

If at any point you click the Spell Check All button, at the bottom of the Check 
window, ClaroRead starts checking your entire Word document from the 
beginning. When in “spell check all” mode: 

• When you click the Change button, ClaroRead proceeds to the next 
misspelled word, rather than showing the Meanings tab for the current 
word. 

• The Change All button is available. Click this button to apply the selected 
correction to every occurrence of the misspelled word in your entire 
document. 

• The Ignore All button is available. Click this button to ignore all occurrences 
of the current word in your entire document. 
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Special Features for Word 

ClaroRead’s spellcheck behaves differently in Microsoft Word, compared to 
how it works in other applications. 

The following features only apply when you are working in Microsoft Word: 

• Quick single-word checking 

Instead of selecting text, just position the cursor in a word (or select a single 
word) and then click Check (or press F9). 

If the word is misspelled, the Check window will help you to correct it (using 
the Spelling tab). If the word is spelled correctly, however, the Check 
window shows its meaning and other information (in the Meaning tab). 

• Spell Check All button 

When checking a word, you can click the Check window’s Spell Check All 
button to check your entire Word document from the beginning. 

• Corrections are applied immediately 

Unlike other applications (where corrections are only made when you the 
Check window closes), spelling corrections in Word are made immediately, 
that is, as soon as you click Change or Change All. 
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Checking Spelling in Other Applications 
In all applications apart from Microsoft Word, you must select text before you 
can check its spelling. 

To check spelling in applications other than Word: 

1. Select the text that you want to check, and then click  (or press F9). 

ClaroRead checks the selected text. If it finds an error, the Check window 
appears, showing the Spelling tab: 

 

If ClaroRead does not find any errors, a “No Spelling Errors!” message is 
displayed. Click OK to close the message. 

Note: You should always select a meaningful amount of text to check. This 
gives context, which helps ClaroRead to identify more complex errors such 
as incorrectly used homophones. See Selecting Text for Context. 
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2. In the Check window, select the appropriate suggestion or synonym (or 
type your own correction into the Word field), and then click Change or 
Change All. 

Remember that, if the error is related to homophones, the Check window 
also shows the Homophones tab, which can help you work out the correct 
homophone to use. 

Alternatively, click Ignore or Ignore All to skip past that error. 

3. ClaroRead continues checking the selected text. If any more errors are 
found, they will be shown in the Check window. 

Note that any corrections are stored for now – they will not be applied until 
the spell check is complete. 

4. Continue making corrections until no errors are found. 

After the last error, ClaroRead closes the Check window and applies all your 
corrections as a single action. 

Finally, a “No Spelling Errors!” message is displayed. 

5. Click OK to close the message and return to your application. 

Note that you can also click the Close button to close the Check window 
before the spellcheck is complete. ClaroRead will apply any corrections that 
you have selected so far. 
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Selecting Text for Context 

ClaroRead’s spellcheck looks for words that have been used incorrectly as well 
as words that have been misspelled. In order to do this, it needs some context, 
which you can supply by selecting more than just one word. 

For example, consider the following sentence: 

I tried to hand in my report but no-one was their. 

The “their” is an incorrect homophone – “there” is the correct word to use in 
this instance. 

If you select only “their”, ClaroRead will not find any mistakes. However, if you 
select the whole sentence, or even part of it, ClaroRead will have enough 
context to recognise that the wrong homophone has been used. 
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Check Window 
When ClaroRead detects a spelling mistake, it shows the Check window’s 
Spelling tab: 

 

Word field 

The word currently being corrected.  

If none of the suggestions or synonyms is suitable, you can edit the misspelled 
word directly by typing in this field.  

Anything you type here becomes the “selected correction” and other parts of 
the window are updated automatically. For example, if you are correcting the 
word “repport” and you type “reports”, the Definition area updates to show the 
meaning of the word “reports” and the picture changes from one report to 
several. 
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Suggestions list 

A list of suggested corrections. The first suggestion is selected by default. 

Click a suggestion to update the rest of the Check window accordingly. 

Synonyms list 

A list of synonyms for the selected suggestion, that is, other words with the 
same (or almost the same) meaning. 

Click a synonym to make that the “selected correction” (instead the selection 
from the Suggestions list) and update the rest of the Check window 
accordingly. 

Picture 

If there is a picture associated with the selected correction, it is shown to the 
right of the Suggestions list. 

Definition area (top right) 

The dictionary definition of the selected correction is shown at the top right of 
the Check window. 

Context area (bottom right) 

The text being spellchecked is shown at the bottom right of the Check window, 
with the selected correction in bold. This shows you how the correction looks 
in your original text. 

Syllabification area (bottom left) 

At the bottom left of the Check window is the syllabification of the selected 
correction, that is, how the word is split into syllables. 
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Lookup button 

Click Lookup to look up the selected suggestion or synonym in an online 
dictionary. 

Mute / Unmute button 

ClaroRead automatically reads out anything that you select or hover the mouse 
pointer over in the Check window.  

Click  to disable this feature, or click  to enable it again. 

Hide / Show button 

You can make the Check window simpler by hiding the right side of the 
window, that is, the Definition area, Context area, and Lookup button. 

Click  to hide the right side of the window, or click  to show it again. 

Add button 

Click Add to add the spelling in the Word field to your custom dictionary. 
ClaroRead will now recognise it as a correct spelling. 

Change and Change All buttons 

After you have selected a suggestion or synonym (or typed your own 
correction into the Word field), click Change to apply the correction. 

Alternatively, click Change All to change every instance of the misspelled word 
in the entire document (Word) or in the selected text (other applications). 
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Ignore and Ignore All buttons 

You can click Ignore to proceed to the next misspelled word without making a 
correction. 

Alternatively, click Ignore All to ignore every instance of the misspelled word in 
the entire document (Word) or in the selected text (other applications). 

Spell Check All button (Word only) 

If you are working in Microsoft Word, click this button to spell check your entire 
document, starting from the beginning. 

Close button 

Click Close to close the Check window immediately, applying any corrections 
that you have selected so far. 

Note that the Check window closes automatically when you complete a 
spellcheck, that is, after you have gone through all corrections in the document 
(Word) or in the selected text (other applications). 
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Homophones Tab 

If ClaroRead identifies a misspelling as a possible misused homophone, for 
example if you have typed “their” instead of “there”, it will be shown in the 
Check window so you can check it and make a correction, if necessary. 

In this case, the Check window will show the Homophones tab in addition to 
the Spelling tab: 

 

The Homophones tab is similar to the Spelling tab, but shows possible 
alternative homophones and their meanings, rather than suggestions and 
synonyms. 

You can still change the current word in the Homophones tab. Select an 
alternative homophone, and then click Change. 

See Homophone Features. 
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Meanings Tab 

If you are working in Microsoft Word and click Check when the cursor is 
positioned in a correctly-spelled word, the Check window shows the Meaning 
tab instead of the Spelling tab: 

 

The Meanings tab is similar to the Spelling tab, but shows possible meanings of 
the current word, rather than suggested corrections. 

You can still change the current word in the Meanings tab. Select a meaning or 
a synonym, and then click Change. 
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Blank Check window 

If ClaroRead does not have additional meanings or synonyms for the current 
word, a partially blank Check window may be shown instead of the Meanings 
tab: 

 

This typically happens for technical terms, names of people or places, or 
custom words that have been added to your Word dictionary. 
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Dictionary Tooltip 
ClaroRead provides you with a speaking dictionary tooltip that gives you a 
spoken definition for any word in any program. 

Either select a single word with your mouse, or hold down the Ctrl key and 
hover your mouse pointer over it. A dictionary tooltip appears: 

 

If you have Speak when mouse selects enabled (in ClaroRead’s Advanced 
Speech Settings), you will also hear the selected word spoken aloud.  

The tooltip contains a definition for the selected word. To hear the definition 
read aloud, point your mouse at the tooltip. If you click a word in the definition, 
it will in turn be defined.  

The syllabification of the selected word is also shown at the top of the tooltip, 
if available. 

The tooltip is limited to three lines of definition text – use the scroll bar at the 
right to read longer definitions. 

We recommend that you select words by clicking and dragging your mouse. 
The tooltip may not appear if you double-click a word, for example, or if you 
select it using your keyboard. 

You can look up the word in an online dictionary by clicking the tooltip’s 

Lookup button . 

The tooltip remains visible until you click its Close button . Alternatively, you 
can drag the tooltip to a new location. 
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By default, the tooltip stays in one place. If you prefer it to move with your 
cursor, select the Tooltip follows cursor checkbox in ClaroRead’s Check 
Settings.  

To turn off dictionary tooltips, clear the Use dictionary tooltip checkbox in 
ClaroRead’s Check Settings. 

Tooltip Translations 

You can use ClaroRead’s dictionary tooltip to translate words automatically 
between your system language and a second language. 

To enable tooltip translations, you must select your second language: 

1. Open ClaroRead’s Settings window. 

2. Select a second language from the Language dropdown list: 

 

The list contains a preconfigured set of second languages for your system 
language. For some languages, it does not appear by default. 

For more details, see Language Selection. 
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3. Open the Check tab and make sure that the Use dictionary tooltip 
checkbox is selected. 

4. Click OK to close the Settings window. 

After tooltip translations have been enabled, ClaroRead’s dictionary tooltip 
automatically translates words from your second language into your system 
language. Definitions are also shown in your second language. 

For example, if your system language is Swedish and you select English as 
your second language, ClaroRead’s dictionary tooltip shows possible Swedish 
translations of the selected (or hovered-over) word, along with its definition in 
English: 

 

If you hover your mouse pointer over the tooltip, you can hear the definition 
spoken aloud, using the voice selected for your second language (in this case, 
English). 
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Homophone Features 
ClaroRead can help you to use homophones correctly. There is a 
homophone checker that works within the Check window – it will alert 
you to homophones, both correct and incorrect, as well as any spelling 
errors that it finds. 

In Microsoft Word, ClaroRead can also highlight homophones in your text, 
making it easier for you to check if you have used them correctly. 

Click the Homophones button on the ClaroRead toolbar to show the following 
options: 

 

• Check Homophones – check homophones from the current cursor position 
(Word) or in the selected text (other applications). 

• Show Homophones (F10) – highlight homophones in the current paragraph 
or the selected text (Word only). 

• Clear Homophones (F11) – remove highlighting from the entire document or 
just the selected text (Word only). 

Like ClaroRead’s Check window, the homophone checker works in many 
applications, with some differences when you are using Microsoft Word. 

If you rarely get a specific homophone wrong, you can exclude it from 
ClaroRead’s homophone checker. You can also add homophones to 
ClaroRead’s list or delete them entirely.  

See Homophones Settings and the Advanced Settings Editor. 
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About homophones 

A homophone is a word that is pronounced the same as another word but 
differs in meaning. The words may be spelled the same, such as rose (flower) 
and rose (past tense of rise), or differently, such as to, two, and too. Or there, 
their, and they’re. 

Homophones can be a problem for many people – misused homophones, such 
as using they’re instead of there, are not incorrect spellings and therefore are 
not always spotted by standard spelling checkers, dictionaries, or read-back 
features. 

ClaroRead can identify the words in your text that are homophones and 
present you with a list of suggestions that sound similar. 
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Highlighting Homophones in Word 
In Microsoft Word, you can use ClaroRead to highlight the homophones in your 
text: 

• If you click Show Homophones (or press F10) without any text selected, 
ClaroRead examines the current paragraph and changes the colour of any 
possible homophones: 

 

In the above example, ClaroRead has highlighted all possible homophones 
in the current paragraph. This includes the incorrect homophones wood 
(which should be would) and its (it’s), as well as correct homophones such 
as find (which could have been fined) and to (two or too). 

• If you click Show Homophones (or press F10) with text selected, ClaroRead 
highlights possible homophones in the selected text only: 

 

This is useful if you only want to check a few words that you are not sure 
about, or if you want to check a longer section of your document. 

• If you click Clear Homophones (or press F11) without any text selected, 
ClaroRead removes homophone highlighting from your entire document. 

• If you click Clear Homophones (or press F11) with text selected, ClaroRead 
removes homophone highlighting from the selected text only. 

You can change the highlight colour in ClaroRead’s Homophones Settings. 
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Note: ClaroRead clears highlighted homophones by changing text colour to 
black. If you are working with a document that uses coloured text, you should 
avoid using Clear Homophones. Instead, you can use Word’s Undo function 
multiple times to return highlighted words to their original colour. 

Checking Homophones in Word 
In Microsoft Word, ClaroRead’s homophone checker (Homophones button) 
behaves slightly differently to its spelling checker (Check button). It gives you 
an in-depth check of your document, rather than a quick check for a single 
word or sentence. This can be slow as ClaroRead will prompt you to check a lot 
of words – we recommend that you use the homophone checker as a final 
check, for example before submitting an important essay. 

To check homophones in Word: 

1. Position the cursor in a word and then click  followed by Check 
Homophones. 

ClaroRead starts checking from the current cursor position. When it finds a 
homophone or a spelling mistake, the Check Window appears: 
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The tabs displayed in the Check window depend on the nature of the 
current word: 

• Correctly-used homophone – Homophones tab. 

• Incorrectly-used homophone – Spelling tab shown, Homophones tab 
available. 

• Spelling mistake – Spelling tab. 

The Meanings tab may also be displayed. 

2. Either: 

• Make a correction and click Change or Change All. ClaroRead applies 
the correction immediately and proceeds to the next homophone or 
spelling mistake. 

• Click Next, Ignore, or Ignore All to proceed to the next homophone or 
spelling mistake. 

ClaroRead continues checking the document for homophones and spelling 
mistakes. If it finds any, they will be shown in the Check window. 

3. Continue making corrections (or clicking Next and Ignore). 

When ClaroRead reaches the end of the document, it closes the Check 
window and shows a message, for example “Finished checking 
homophones”. 

4. Click OK to close the message and return to Word. 

Note that you can click the Check window’s Close button at any time to end 
the homophone check.  
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Checking Homophones in Other Applications 
In all applications apart from Microsoft Word, you must select text before you 
can check homophones. 

To check homophones in applications other than Word: 

1. Select the text that you want to check, and then click  followed by 
Check Homophones. 

ClaroRead checks the selected text. If it finds a homophone or spelling 
mistake, the Check Window appears: 

 

The tabs displayed in the Check window depend on the nature of the 
current word: 

• Correctly-used homophone – Homophones tab. 

• Incorrectly-used homophone – Spelling tab shown, Homophones tab 
available. 

• Spelling mistake – Spelling tab. 

The Meanings tab may also be displayed. 
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2. Either: 

• Make a correction and click Change or Change All. ClaroRead stores the 
correction and proceeds to the next homophone or spelling mistake. 

• Click Next, Ignore, or Ignore All to proceed to the next homophone or 
spelling mistake. 

ClaroRead continues checking the selected text for homophones and 
spelling mistakes. If it finds any, they will be shown in the Check window. 

Note that any corrections are stored for now – they will not be applied until 
the homophone check is complete. 

3. Continue making corrections (or clicking Next or Ignore). 

4. When ClaroRead reaches the end of the selected text, it closes the Check 
window and applies all your corrections as a single action. 

Finally, a message appears, for example “Finished checking homophones”. 

5. Click OK to close the message and return to your application. 

Note that you can click the Check window’s Close button at any time to end 
the homophone check. ClaroRead will apply any corrections that you have 
selected so far. 

 



 

  61 

Word Prediction Features 
You can enable the Predict button in ClaroRead’s View Settings. 

ClaroRead contains a powerful word prediction feature, which can be 
helpful for your personal problem words, new vocabulary, poor spellers, 
foreign-language speakers, and people with problems using a keyboard. 
Click the Predict button to toggle word prediction on and off. 

ClaroRead tries to predict the words you want to use next in a sentence. It 
learns these words as you type them, and will make suggestions based on 
previous documents. It takes into consideration the frequency and order in 
which you use certain words, to help you construct sentences quickly and 
easily. 

The words that appear depend on your selected prediction dictionary. You can 
choose subject-specific dictionaries, like Accountancy or Biology, use a small 
prediction dictionary of common English words, use your own prediction 
dictionary, or use a large English dictionary of 100,000 words.  

ClaroRead’s word prediction is highly configurable. As well as selecting a 
prediction dictionary (or even creating your own), you can choose between 
several prediction styles, set the number of letters needed for word prediction, 
control how the Prediction List looks, and so on.  

See Prediction Settings and the Advanced Settings Editor. 
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Using Word Prediction 

To activate word prediction, click the  button. The button turns blue  
to indicate that prediction is on. 

Now, when you start typing in any application, a small Prediction List appears: 

 

The Prediction List shows the five most likely words, based on the letters that 
you have already typed. Where available, small pictures are shown to help you 
choose words quickly. 

To insert one of the predicted words into your document, either press the 
corresponding function key (F1 to F5), or click the word with your mouse. 
ClaroRead inserts the selected word and automatically adds a space in 
preparation for the next word. 

If the word you want is not displayed, either type more letters, or click the  
arrow at the bottom of the Prediction List. 

By default, the Prediction List appears at a fixed position on your screen. As it 
always appears in the same place, you know where to look for a word 
prediction. You can drag it to a new position, for example to keep it in your 
eyeline when working in a different application. 
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Prediction wildcards 

You can use wildcards in predictions, that is, symbols that can be used to 
represent any character. ClaroRead’s word prediction supports the following 
wildcards: 

_ (underscore) – use to represent one or more characters. 

* (asterisk) – use to represent a single character. 

For example, when you type “h_e”, predicted words may include horse, home, 
and hope – any number of characters may be between the h and the e. The e 
may not be the last character in the word, so words like however and himself 
may also appear, depending on the selected prediction style. 

When you type “h*t”, all predicted words will have a single letter between the h 
and the t, for example hat, hit, and hot. Words like hotel and hitting may also 
appear. 

Using F1–F5 in other applications 

If ClaroRead is using the F1, F2, F3, F4 and F5 keys for word prediction, you 
cannot use them in other applications, for example to open an application’s 
help. If you want to bypass ClaroRead’s word prediction and use a function key 
with the current application, press F6 first and then your choice of F1 to F5. 
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Prediction List Options 
You can right-click the Prediction List to open a menu showing its options: 

 

You can choose between four prediction styles: 

• Completion (c > cat) 

This is a conventional word prediction style, which predicts words based on 
exactly what you type.  

For example, if you type the letter “c”, words like cat and celery might 
appear in the Prediction List. 

• Phonetic (k > cat) 

This is the default style, and predicts words based on how they sound 
rather than how they are spelled. 

For example, if you type the letter “k”, words that might appear include cat, 
competition, and cow, all of which start with a “k” sound, despite being 
spelled with a “c”. 

This style is good for people who can spell phonetically but are not good 
with irregular spellings. 
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• First and Contains (gdt > graduate) 

This style matches the first letter you type, and then the ones after it in 
order, anywhere in the word. 

For example, if you type the letters “gdt”, words that might appear include 
graduate, grandfather, and goodnight. 

This style is good for people who usually get the first letter right but are not 
sure what comes afterwards, although they can usually guess or remember 
some more letters.  

• Contains Anywhere (ptg > sporting) 

This style matches the letters you type anywhere in a word, in any order.  

For example, if you type the letters “ptg”, words that might appear include 
sporting, copyright, stopping, and photographs. 

This style is especially helpful for people who really struggle with spelling, 
bringing up the most suggestions and the widest range of matches. 
However, as it brings up so many suggestions, it is best used with a small 
prediction dictionary. 

You can also enable Window follows cursor. Rather than the Prediction List 
appearing at a fixed position on your screen, it will appear just below your 
cursor, in any application that you use. 

Note that many more word prediction settings are available, including how the 
Prediction List looks and how prediction behaves. See Prediction Settings. 
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Save Feature 
ClaroRead’s Save button saves text as an audio file so that you can 
listen to it later. For example, you might have notes from a lecture that 
you want to listen to on your mobile device while you’re on your way to 
college. 

To save text as an audio file: 

1. Display the text that you want to save. Depending on the application you 
are using, you may need to select the text or copy it to the clipboard. For 
example: 

• Microsoft Word and PowerPoint – ClaroRead saves the selected text to 
audio. If nothing is selected, it saves the entire document. 

• Adobe Acrobat – ClaroRead saves the currently displayed page of the 
PDF to audio. 

• Web browsers and most other applications – ClaroRead saves the 
contents of the Windows clipboard to audio. For example, to save text 
from Google Chrome, you need to copy it to the clipboard before you 
click Save. 

2. Click . 

A standard Save As window appears.  

3. Enter a location and name for the audio file. 

4. If you want to use a file format other than MP3 (the default), select it from 
the Save as type dropdown list. 

Available formats are MP3 (.mp3), Windows Media Audio (.wma), Waveform 
Audio (.wav), and Ogg Vorbis (.ogg).  
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Use the format that works best with your computer’s media player or your 
portable audio device – while .wav files work on the largest range of 
devices, for example, they are much larger than .mp3 files. 

5. Click Save. 

ClaroRead shows a progress bar while it saves your text to the specified 
audio file. For long documents, this can take a significant amount of time. 

The text is read out using your standard voice, speed, and so on, as 
configured in ClaroRead’s Speech settings. 
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ClaroRead Extras 
The Extras button provides a handy link to selected other software 
programs. If you have any of the following programs installed, they will 
appear in the list. 

You can edit the items shown on the Extras menu. See Extras Editor. 

ScreenRuler 

ScreenRuler places a tinted strip (“ruler”) or a solid line (“underline”) across the 
screen that moves with your pointer and helps you to focus on the current line 
or paragraph. You can configure the strip’s colour as well as tinting the screen 
outside it. For example, many users find a pale ruler on a darkened screen 
helpful. 

ClaroView 

ClaroView provides a tinted overlay for your whole screen, which may make it 
easier to read than the usual black-on-white text. You can choose colour and 
intensity to match lighting conditions, the time of day, or simply your own 
preference. 

There is also a TrueBlack mode, which tints the page background while leaving 
text (and other dark colours) unchanged. This is similar to the effect of a 
physical filter and may work better for some users. 

Capture 

Capture is a study skills tool that enables you to capture text and images from 
different locations into one “Capture project”. This helps you gather information 
in preparation for writing documents such as essays or reports. 

Note that Capture replaces the older ClaroCapture tool. 
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ClaroIdeas 

ClaroIdeas is a mind mapping and idea capture program that helps with 
research, planning, outlining, studying and presenting. It helps users and 
groups to capture their ideas, pictures, research notes, web page links, audio 
and video files with more freedom, flexibility and creativity. 

AudioNote 

AudioNote enables you to record lectures and audio notes into Word 
documents and PowerPoint presentations, and to play back your own 
recordings with index marks. 

Claro BookReader (Netherlands only) 

Claro BookReader is a self-contained PDF reader that reads PDFs aloud using 
high-quality synthesised speech with synchronised highlighting. You can 
change background colours to make your PDFs easier to read, as well as 
adding your own highlighting and annotations. 

Note that BookReader is only available in the Netherlands – for all other 
countries, use ClaroPDF instead. 

ClaroPDF 

ClaroPDF is a simple cross-platform PDF reader that reads PDFs aloud using 
high-quality synthesised speech with synchronised highlighting. You can add 
highlighting and simple annotations. PDFs saved using ClaroPDF are fully 
compatible with Adobe Acrobat and other popular PDF applications. 

Speaking Calculator 

The Claro Speaking Calculator is a simple calculator that speaks each number 
or operation as you click its buttons (or use your keyboard), and then speaks 
the result when you click Equals (or press Enter). It also includes a Repeat 
button that reads out the previous calculation in its entirety. 
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Auto Converter 

The Auto Converter makes Word, accessible PDF, or plain text versions of 
documents or images that you save or copy into a monitored folder. 

See Auto Converter. 

Batch Audio Converter 

The Batch Audio Converter makes audio files from every document in a 
specified folder, just as if you had used ClaroRead to read each document 
aloud. 

Supported input file types include .pdf (accessible only), .docx, .doc, .odt, .rtf, 
.txt, and .htm. You must have Microsoft Word 2013 or later installed. 

ScreenMarker 

Simple utility for adding markers to your screen. Each time you run 
ScreenMarker, you will be able to place a single pushpin marker on your 
screen, which remains in position until you remove it. 

To change the icon used for a marker, right-click it, select Load, and then 
choose an image file. The available icons include different coloured pins, memo 
notes, underlines, and so on. 

To remove a marker, right-click it and then select Exit. 

Advanced Settings Editor 

The Advanced Settings Editor contains additional configuration options 
including spelling, homophone, and prediction functions. 

See Advanced Settings Editor. 
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Extras Editor 
The Extras Editor enables you to edit the items shown on ClaroRead’s Extras 
menu. 

You can add new items (including web pages and other installed applications), 
remove items you don’t use, and change the item order. 

 

You can run the Extras Editor from the Claro Software folder in your Start 
menu.  
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Auto Converter 
The Auto Converter makes accessible Word, PDF, or plain text versions of 
documents or images that you save or copy into a monitored folder. 

Supported input file types include .pdf, .gif, .tif, .jpg, .bmp, .png, .kes, .epub, 
.docx, .doc, .rtf, and .s2t 

 

To configure and start the Auto Converter: 

1. Run the Auto Converter from either the Extras button on the ClaroRead 
toolbar, or the Claro Software folder in your Start menu. 

2. In the Auto Converter window, click  and specify a folder to monitor. 

Note that you can click  to open the folder and check its current 
contents. 

3. Select the checkboxes for the required output file types. 



 

  73 

4. Click OK. 

The Auto Converter minimises to the Windows System Tray and attempts to 
convert any input files that you save or copy to its monitored folder. Once 
processed, input file names are suffixed with [ORIG] and output files are 
suffixed with [PDF], [WORD], or [TEXT]. 
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Scanning Features 
ClaroRead’s speech features all speak text that is on your screen, for 
example in Microsoft Word or a web browser. However, some text is 
inaccessible, that is, it cannot be selected and read out normally – for 

example, text that is part of an image, or a section of a web page that cannot 
be selected, or even on a sheet of paper. For inaccessible text, you can use 
ClaroRead’s scanning features. 

ClaroRead’s scanning features use the powerful OmniPage optical character 
recognition (OCR) technology to take any text, even if it is not encoded as 
words and characters, and convert it into standard text that can be used in 
your documents and read out by ClaroRead. 

Click the Scan button on the ClaroRead toolbar to show the available options: 

 

  

• Scan from Paper – scans a paper document and converts it to standard 
text, with the output sent directly into a Word document or saved to file.  

• Scan from PDF/File – scans inaccessible text in an electronic format, such 
as a non-textual PDF or an image file, and converts it into standard text. 
Output can be sent directly into a Word document or saved to file. 

• Scan from screen – scans text from the screen, even if that text cannot be 
selected normally, and sends it to the clipboard as standard text. 
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Scanning from Paper 
The Scan from Paper option uses your scanner to scan a paper document – for 
example, pages from a book, a newspaper, or a handout. ClaroRead then uses 
OCR to convert that document to usable text before sending it directly into a 
Word document (where it can be spoken aloud) or saving it to a file that can be 
read out or edited later. 

To scan a paper document: 

1. Get your scanner ready. Switch it on, if necessary, and place your document 
on its scanning surface or in its sheet feeder. 

2. Click  and then Scan from Paper. 

3. If you have no scanners set up, for example if this is the first time you have 
used ClaroRead to scan a document, the Scanner Setup wizard opens. 
Follow the instructions in the wizard to set up your scanner. 

See Scanner Setup Wizard. 

4. ClaroRead starts its scanning process. Depending on your scanner setup, 
ClaroRead either: 

• Scans the document immediately using its own settings, as configured in 
the Scanner Setup wizard. 

• Opens a scanning utility. Perform the required steps to complete the 
scan – for example, check settings and then click Scan. 

• Prompts for a file to scan (if using “File: Pictures” as your scanner). 
Select a file and click Open. 
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5. When the scan is complete, ClaroRead prompts for additional pages: 

 

Click Yes to repeat the scanning process for the next page, or No to 
continue. 

Note that, depending on your scanner setup, you may already have scanned 
multiple pages – if your scanner has an automatic document feeder, for 
instance. If you have scanned all the pages that you need, simply click No. 

6. The Preview window appears, showing text flow in your scanned document: 

 

Use the Preview window to set reading order, remove parts of the 
document that you do not want to scan, and so on. 

See Preview Window. 
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Note: While ClaroRead is configured by default to show the Preview 
window, the Preview scanned image option may have been turned off in 
ClaroRead’s Scan Settings. If so, you will be prompted to save the scanned 
document to file instead, without the Preview window appearing. 

7. When you have finished adjusting the document, click one of the following 
buttons: 

• Send to Word – send text from the document directly to the currently 
open Word document. Before clicking this button, make sure that you 
have the correct document open and that the cursor is positioned at the 
place that you want to insert text.  

If you are not currently working in Word, ClaroRead inserts the scanned 
text into a new Word document. 

Sending scanned text to Word means that it is ready to be edited or read 
out by ClaroRead immediately. 

• Save as PDF – save the scanned document as a Claro PDF file. Specify a 
file name and location, and then click Save. 

Saving as a PDF gives you an exact copy of the original document, with 
accessible text that you can read out using ClaroRead, copy to other 
applications, and so on. 

• Save As – save the scanned document to a one of several file formats. 
Specify a location, file name, and file type, and then click OK.  

Note: If the Proofread before converting to text option is enabled in 
ClaroRead’s Scan Settings, the Preview window will not show the Send to 
Word, Save as PDF, and Save As buttons described above. Instead, click OK 
to proceed to the Proofing window – the three buttons will appear there 
instead so you can use them after you have finished checking and 
correcting the document. See Proofing Window. 
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Scanning from PDF or File 
The Scan from PDF/File option takes a file containing inaccessible text, for 
example a non-textual PDF or an image, and converts it into standard (or 
accessible) text, saved to a file. 

Inaccessible text is text that is not encoded as words and characters. For 
example, scanned documents are often saved as inaccessible PDFs, which are 
pictures of the scanned page rather than text that you can select, copy, and so 
on. You will know that a PDF is inaccessible when you cannot select text using 
Adobe Acrobat’s Selection tool. 

Another example is when you take a photo of a sign or document using your 
smartphone – this is a picture of some text rather than text that you can use. 
ClaroRead cannot read out inaccessible text, and neither can other programs. 

ClaroRead can scan files and use its OCR to make inaccessible text into 
standard text – actual words and letters. ClaroRead’s “Scan from PDF/File” 
feature can handle PDFs and a wide range of other file formats, including .gif, 
.tif, .jpg, .bmp, .png, .kes, .epub, .docx, .doc, .rtf, and .s2t. 

You may also find that even accessible PDFs, which can already be read out in 
ClaroRead, will read out much better if you scan them and then save them to 
PDF again. This is because the ClaroRead scanning process is optimised to 
produce readable PDF files. 

For more details on accessible PDFs, see Making Accessible PDFs. 

To scan from a PDF or file: 

1. Click  and then Scan from PDF/File. 

ClaroRead prompts for a PDF or image file to scan.  

2. Select a file and then click Open. 
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3. ClaroRead scans the specified file and opens the Preview window: 

 

Use the Preview window to set reading order, remove parts of the 
document that you do not want to scan, and so on. 

See Preview Window. 

Note: While ClaroRead is configured by default to show the Preview 
window, the Preview scanned image option may have been turned off in 
ClaroRead’s Scan Settings. If so, you will be prompted to save the scanned 
document to file instead, without the Preview window appearing. 

4. When you have finished adjusting the document, click one of the following 
buttons: 

• Send to Word – send text from the document directly to the currently 
open Word document. Before clicking this button, make sure that you 
have the correct document open and that the cursor is positioned at the 
place that you want to insert text.  
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If you are not currently working in Word, ClaroRead inserts the scanned 
text into a new Word document. 

Sending scanned text to Word means that it is ready to be edited or read 
out by ClaroRead immediately. 

• Save as PDF – save the scanned document as a Claro PDF file. Specify a 
file name and location, and then click Save. 

Saving as a PDF gives you an exact copy of the original document, with 
accessible text that you can read out using ClaroRead, copy to other 
applications, and so on. 

• Save As – save the scanned document to one of several file formats. 
Specify a location, file name, and file type, and then click OK.  

Note: If the Proofread before converting to text option is enabled in 
ClaroRead’s Scan Settings, the Preview window will not show the Send to 
Word, Save as PDF, and Save As buttons described above. Instead, click OK 
to proceed to the Proofing window – the three buttons will appear there 
instead so you can use them after you have finished checking and 
correcting the document. See Proofing Window. 
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Scanning from Screen  
The Scan from screen option scans part of your screen, uses OCR to identify 
any text, and then saves that text to the Windows clipboard. 

This is useful if you can see some text on your screen but you cannot access it 
– for example, an inaccessible part of a web page, an application that does not 
let you copy text, or text from an image. 

To scan text from your screen: 

1. Make the text you want to scan as large as possible. 

This helps ClaroRead to recognise the text correctly – computer displays 
typically have a much lower resolution than a printed page, so it can be 
more difficult to use OCR with on-screen text. 

2. Click  and then Scan from screen. 

Your screen freezes and the mouse pointer changes to a crosshair, waiting 
for you to select the area that you want to scan. 

3. Click the left mouse button and hold it while you drag out a rectangle 
around the text that you want to scan. 

ClaroRead overlays your screen with a blue rectangle as you select the 
scanning area: 
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4. Release the left mouse button. 

ClaroRead scans the area you selected. It reads out any text that it finds, 
and then copies it to the clipboard. 

If you want to hear the copied text again, click  to read it out from the 
clipboard. 

If you want to see the text, or read it out with highlighting, simply paste it 
into Microsoft Word (or similar). 



 

  83 

Preview Window 
ClaroRead’s Preview window shows you a preview of the scanned document 
and gives you options for setting reading order and removing parts of the 
document that you do not want to scan. 

Reading order is very important when making accessible PDFs. See Making 
Accessible PDFs. 

The Preview window also enables you to choose whether you want to send the 
scanned document directly to Word or to save it to file, either as a PDF or to 
another format. 

 

Note that, if the Proofing window is enabled, the Preview window will not 
contain Send to Word, Save as PDF, or Save As buttons. Instead, it will have 
an OK button that saves changes and opens the Proofing window. 

By default, ClaroRead shows the Preview window as part of the Scan from 
Paper and Scan from PDF/File processes. If you do not want the window to 
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appear, for example if you always want to save the scanned document as a file, 
clear the Preview scanned image checkbox in ClaroRead’s Scan Settings. 

Page Thumbnails View 

Thumbnails of each page in your document are shown at the left of the Preview 
window. You can: 

• Quickly navigate through your document by clicking page thumbnails. 

• Add pages by clicking Add pages and then scanning additional material. 

• Delete pages by selecting them and then clicking Delete pages. These 
pages will not be included in the final output document. 

• Reorder pages by dragging their thumbnails to new positions. 

The  icon is shown at the bottom of the current page’s thumbnail, while all 

page thumbnails shown in the Preview window have a  icon, indicating that 
they have not yet been recognised, that is, have not yet been OCR’d.  

Note that this view is also included in the Proofing window, with additional 
icons to indicate the processing of each page. 

Main Preview Area 

The main Preview area in the centre of the Preview window shows each page 
and what will be scanned (OCR’d) on each page. These are called zones. Text 
zones and images that will be scanned are marked with boxes and icons: 

Text zone to be scanned. The text in a text zone will be OCR’d and 
available for reading or editing. 

Image zone to be scanned. Any text in an image zone will not be readable, 
because it will not be OCR’d. It will appear exactly like the original 
document, just as you see it here.  

You can edit these zones to control what is scanned and OCR’d. See Selecting 
what is going to be scanned. 
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Preview Toolbar 

To the left of the Preview area is a toolbar with many buttons: 

Select zones with the mouse. 

Clear the selected zone(s). Select areas that contain scanning errors 
(marks on the original paper) and useless text (such as repeated header 
and footer content) and then click this button to stop them appearing in 
your output. 

Create a text zone. Only text in a text zone will be scanned and appear in 
your output. 

Create an image zone. Only images in an image zone will be scanned and 
appear in your output. 

Create a table zone. 

Removes part of a zone. Use to create irregular zones around text and 
images that are not in simple rectangles. 

Clear all zones on this page. Useful shortcut if you want to redraw them 
all manually. 

Change the reading order of the output file. Useful if you are saving to a 
PDF. See Setting the reading order. 

Zoom into the Preview. 

Zoom out of the Preview. 

Zoom so that the current page fits entirely into the Preview window. You 
can maximise the Preview window to make it bigger, or zoom in to see a 
section in more detail. 

Flip the whole page along its vertical axis (so left goes to right and right 
to left). 
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Rotate the page anti-clockwise. 

Rotate the page clockwise. 

Rotate the page 180 degrees. Useful if your scanner has presented the 
page upside down and ClaroRead has not managed to reverse it. 

Print this whole set of scanned pages. This can be handy if you want to 
copy pages – just scan and then print, without having to go through a 
document format in between. 

Setting the reading order 

Reading order is very important if you are making accessible PDFs.  

To set the reading order for a page, click the Change Zone Order button , 
then click each zone (image or block of text) in the Preview in order. Arrows 
and numbers on each zone show the final order. 

Deleting pages from an input document 

You can remove pages from an input document. For example, you may only 
want to scan one chapter from a PDF file. 

To delete pages, select their thumbnails in the Page Thumbnails View, and then 
click the Delete pages button (at the bottom left of the Preview window). 

Combining documents and adding pages 

You can combine pages and documents together. This is useful if you interrupt 
scanning half-way through and want to add more pages, or if you want to 
combine multiple images or PDF files into one PDF or Word document. 

Open a file or scan a document as usual, then click the Add pages button (at 
the bottom left of the Preview window). Select to scan a page or add a new file 
and they will be added to the current document. 
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You can also change the order of pages in your document. Click a page’s 
thumbnail in the Page Thumbnails View, hold down the mouse button, and drag 
the page to a new position in the document. 

Selecting what is going to be scanned 

ClaroRead does its best to make sense of everything on a page, so sometimes 
it can try to scan sections that you don’t want, like marks on the page from 
scanning or images you don't want in the output. 

The areas that are going to be scanned are called “zones”. You can add, 
delete, and edit zones using the buttons on the Preview toolbar. 

Example of editing zones 

Consider the following document, which has been scanned from a PDF file: 

 

ClaroRead has identified a speech bubble as part of an image zone  so, 
when the scanning process is complete, it will appear as an image in the output 
document.  

We would prefer the speech in the bubble to be a text zone , so that it will 
become text that can be selected, read aloud, and so on. 



 

  88 

To make this correction in the Preview window: 

1. Click the image zone to select it: 

 

2. Click Clear Selected Zones  to remove the selected image zone. It will 
no longer appear in the output document: 
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3. Click Draw Text Zone  and then select the area containing the text you 
want to scan and OCR – in this case, the contents of the speech bubble. 
This text will now appear as readable text in the output document, rather 
than being marked as an image: 

 

 

4. Note how the speech bubble has a 2 in its upper right corner. This means 
that it is now the second thing to be read out on the page – it should be the 

first. Click Change Zone Order  and then click the two text zones in 
turn. This will set their reading order correctly: 
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Proofing Window 
The Proofing window contains options for editing scanned documents before 
you save them. You can check spelling, edit text (both content and formatting), 
redact or highlight text, and so on. 

The Proofing window is not enabled by default. To enable it, select the 
Proofread before converting to text checkbox in ClaroRead’s Scan Settings. 

If enabled, the Proofing window appears after the Preview window. If 
ClaroRead has identified any possible errors in your document, the OCR 
Proofreader tool starts automatically: 

 

Use the Proofing window to correct any OCR errors in your scanned document, 
and then click one of the buttons at the top right of the window to send it to 
Word, save it as a PDF, or save it as another file type. 
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OCR Proofreader 

You can use the OCR Proofreader to step through any errors flagged in your 
scanned document, for example characters with low legibility and words that 
ClaroRead is not sure about. The panel at the top of the window shows the 
exact scanned copy, with the current match and a number of alternative 
suggestions shown below it: 

 

You can decide whether to correct or ignore each error, or add it to your 
proofreading dictionary. You can make corrections in the OCR Proofreader or in 
the Proofing window’s Text Editor pane. 

When you have finished with a page, or the entire document, click the Page 
Ready or Document Ready button and no more errors will be identified. 

At the bottom of the OCR Proofreader window is a Character Map, which you 
can use to find and insert symbols and other special characters. 

You can close the OCR Proofreader at any time, and restart it by selecting 
Proofread from the from the Proofing window’s Tools menu. Note that the OCR 
Proofreader will only open if there are possible errors flagged in your 
document. 
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Text Editor 

In the centre of the Proofing window is the Text Editor. This shows any 
detected errors with a red underline, just like Microsoft Word. You can use this 
to correct spelling and recognition mistakes in your document, either by typing 
directly into the Text Editor or by right-clicking each error and selecting a 
suggested correction from the pop-up menu. 

To move to the next identified error, either select Tools > Find next suspect, 
or press Ctrl+N. 

The Text Editor always shows pages in their original format, so you can easily 
match up text to the original document. However, your Keep original format or 
Simplify format setting (in ClaroRead’s Scan Settings) will always be used for 
the final output. 

Verifier 

In the Proofing window, you are working with what ClaroRead thinks is the 
underlying page content. If you are scanning from a paper or an image file then 
this may be inaccurate – for example, you may have a damaged area of the 
paper that has confused ClaroRead. It might be hard to correct the text in the 
Proofing view if you don't have sight of the original image. 

The Verifier pane, above the Text Editor, provides you with a view of the 
underlying image that ClaroRead is processing. This helps you check the text 
you have got (in the Text Editor) against the original page (in the Verifier):  

 



 

  93 

Click text in the Text Editor to show its underlying image in the Verifier. You 
can zoom in and out to check smaller details by clicking the image in the 
Verifier, or by selecting Verifier > Zoom from the View menu. 

If the Verifier is not visible, you can turn it on by selecting Verifier > Show from 
the View menu. 

By default the Verifier is shown above the Text Editor. To make it float (follow 
the cursor), select View > Verifier > Dynamic. To change what is shown in the 
floating Verifier, select View > Verifier > Line / Three words / One word. 

Page Thumbnail View 

Thumbnails of each page in your document are shown at the left of the 
Proofing window, just like in the Preview window. You can: 

• Quickly navigate through your document by clicking page thumbnails. 

• Add pages by clicking Add pages and then scanning additional material. 

• Delete pages by selecting their thumbnails and then clicking Delete pages. 
These pages will not be included in the final output document. 

• Reorder pages by dragging their thumbnails to new positions. 

Icons at the bottom of each thumbnail indicate the status of that page: 

The current selected page. 

A page that has not yet been recognised (OCR’d). This is usually seen in 
the Preview window. 

A page that has been recognised (OCR’d) but not otherwise modified in 
the Proofing window. 

A page that has been recognised (OCR’d) and proofread. 

A page that you have modified in the Proofing window. 

A page that has been modified and proofread. 
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Status Bar, Ruler and Toolbars 

You can turn these on and off in the View menu. They are all off by default. 

• The Formatting toolbar has Style, Font, Alignment, Bullets and Show 
Paragraph buttons, just like Word or WordPad. These can be used to edit 
the text in the proofing view so you can get the appearance of your final 
output just right. 

• The Mark text toolbar has Highlight and Strikeout buttons, which you can 
use to mark up your document. It also has a redacting tool you can use to 
mark sections of text that you want to appear with black rectangles 
overlying the text (so you can see where the text was). Select the text that 
you want redacted, and then click the Mark for Redacting button. After you 
have finished marking your text, click the Redact Document button to 
redact it all. 

• The Ruler gives you the dimensions of the current page or text area. You 
can change the units by selecting View > Measurement units > Inches / 
Centimetres / Points / Picas. 

• The Status Bar shows you the position of the cursor and the language that 
ClaroRead believes is the writing of the text. This is useful because if it does 
not match the actual language of the text then the text will be incorrectly 
recognised and spell checked. Use the Set Language... option in the Tools 
menu to change the selected language. 
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Views 

You can view the current page in one of three ways, selected from the View > 
Text editor views menu: 

• True page means the page will be displayed on the screen as it was laid out 
on the original paper. This is useful to identify page reading order and to 
make sense of the structure of a page. This is the default. 

• Formatted text extracts the text content but keeps font, colour and font 
size so it is like editing a Word document. This may be simpler. It better 
represents the output of the page if you are creating a re-flowing PDF file. 

• Plain text presents only the text content. This is best if you want to work 
with the text content only, for example if you will be converting the text to 
audio. 

Character Map 

You may have non-standard characters for your current language in your text. 
For example, in a maths textbook you will often have Greek characters like 
sigma (Σ) or pi (π). This may confuse ClaroRead – if you are scanning in English, 
for instance, ClaroRead will try to fit every letter into an English character, 
which will produce incorrect results.  

To help you correct these misrecognitions, the Proofing window includes a 
Character Map. This can be used in two different places: 

• The bottom of the OCR Proofreader. This enables you to use special 
characters within the OCR Proofreader: 
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• Under the Formatting toolbar (View > Formatting toolbar). Click the  
button, at the far right of the toolbar, to toggle the Character Map. This 
enables you to use special characters within the Text Editor: 

 

In each case, there is a Recent Characters list (at the top or left) showing 
recently used special characters, and a Character Set list (bottom or right) to 
browse for other special characters. Click a special character in either area to 
add it to your text. You can use the small arrow buttons to scroll through each 
list. 

To use additional character sets, right-click the Character Map, select 
Character Sets from the pop-up menu, and select a character set from the list 
that appears. Greek and Coptic, for example, or Dingbats. ClaroRead will 
remember your selection for next time.  
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Character Training 

You may want to correct some sections of text which have been incorrectly 
identified, like Greek letters used in maths or scanned text from paper. These 
characters or sections will be highlighted in yellow in the Text Editor.  

To correct and train a character: 

1. Click on the character to place the cursor on it. 

2. Select Tools > Train character recognition. 

The Train Character window opens, showing the original text or image 
alongside what ClaroRead thinks it is.  

3. Enter the correct character or characters in the Correct box, and then click 
Train to correct the scanned text.  

ClaroRead makes the correction and remembers it for next time. 

You can review the character training by selecting Tools > Edit character 
training. The Edit Training window opens, showing a list of trained characters. 
Double-click an entry to edit it. If you do not want an entry to be saved, select 
it and then press the Delete key. 

You may need to train several characters, for example where ClaroRead has 
incorrectly identified a single letter as several letters. Simply select all the 
affected letters before you click Train character recognition and the training 
and correction will be applied to all the letters. 
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Formatting Text 

You can edit text in the Proofing window, with the Format menu enabling you 
to change font, paragraph alignment, style and other text attributes. You can 
also select View > Formatting toolbar to show a Formatting toolbar at the top 
of the Text Editor. 

This is useful if you are planning to save the document as a PDF file and want 
to amend how it will look, for example using a more readable font to replace 
what has been used in the original scanned document. However, if you are 
sending the document to Word to read or edit, you will probably find this easier 
to do there. 

Note that, if you are saving as PDF, the original position and size of text areas 
will be retained. So if you make text bigger it will start to overlap and bits will 
be missing. If you want to edit or correct the document you are scanning, we 
suggest sending it to Microsoft Word rather than using the Proofing window. 

User Dictionary 

You can review any spellings you have added to the proofreading dictionary by 
selecting Tools > Edit user dictionary. This shows a list of the words that will 
be recognised as correct spellings: 

 

You can delete any words that should not be there, that is, words that should 
be marked as incorrectly spelled. 
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Language 

It is vital that the language of the scanned document is set correctly, or 
ClaroRead will not recognise (OCR) it correctly, identifying all words as 
incorrectly spelled.  

The Proofing window’s status bar (View > Status Bar) shows the language of 
the current text (where the cursor is positioned).  

To specify a language for your text, select it in the Text Editor, select Tools > 
Set Language…, and then select a language from the list: 
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Making Accessible PDFs 
PDF files are very common but can be very hard to use. ClaroRead Plus and 
Pro give you ways to make them usable and accessible. 

This is a guide to making accessible PDF files with ClaroRead. For an in-depth 
discussion of PDF accessibility, see the PDFs and Accessibility guide on our 
website. 

Quick approach 

This is suitable for individual users who want to make PDF files for their own 
use from scanning books or documents, or who have a PDF file that they need 
to read but is inaccessible (does not read at all or does not read very well). 

1. Scan using ClaroRead. 

2. Click Save As and save as a Claro PDF file. This will automatically be made 
accessible by ClaroRead. 

3. Read back the PDF file by opening it with Adobe Reader and reading it with 
ClaroRead. 

4. Keep the original PDF file for future reference – much quicker than scanning 
it again. 

You can always re-scan the PDF file with ClaroRead if you want to alter its 
accessibility or format, or convert it into Microsoft Word to edit it. 

The ClaroRead scanning process is optimised to produce an accessible PDF 
file, so even if you can read a PDF okay but you have some problems (like 
jumping around the page), it may work better if you scan it and save as a PDF 
file again. 

https://support.texthelp.com/help/pdfs-and-accessibility
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Advanced approach 

This is suitable for someone who wants to create a canonical, high-quality 
accessible PDF file, maybe for redistribution or long-term storage. It works 
best with ClaroRead’s Proofing window, although you can still correct the 
reading order in the Preview window. 

1. Decide on your target audience. The basic split is “screenreader users and 
people with very low vision” versus “mouse users and people with reading 
problems”. Or “blind” versus “dyslexic” to simplify. 

See the PDFs and Accessibility guide on our website for a discussion on the 
differences. 

2. Decide how much work you want to do on the document content. Are you 
essentially making the existing file accessible (for a dyslexic user, for 
example) or are you doing more work to re-purpose the content more 
fundamentally (stripping out extraneous content for screenreader users, for 
example)? 

3. ClaroRead settings: 

a. Turn on Preview and (optionally) Proofing in the Scan Settings. 

b. Set the correct OCR language in the Scan Settings. 

c. For “blind” users consider turning off images and simplifying format. For 
“dyslexic” users turn on images and use the original format. 

4. Scan in from paper or file using ClaroRead. 

ClaroRead will attempt to determine the correct reading order in the 
document, and remove unwanted images. 

5. Correct reading order in the Preview Window: 

a. Delete superfluous content for “blind” users such as headers and footers. 

b. Remove page numbers and other non-reading content for “dyslexic” 
users. 

https://support.texthelp.com/help/pdfs-and-accessibility
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ClaroRead now performs OCR, converting all inaccessible content into 
accessible text. 

6. If the Proofing Window is enabled, use it to correct text content: 

a. Correct spellings and incorrect OCR results. 

b. Add full stops at the end of titles and other lines without punctuation. 

7. Output to your desired format. Either: 

• If you need to make major changes to the document, click Send to Word.  

Word is a far better editing and word processing tool than ClaroRead. If 
you have Word 2010 or later, you can then save the Word document as a 
PDF file directly. Make sure it is tagged (by checking that the Document 
structure tags for accessibility checkbox is selected under the Save As 
window’s options when you are saving as a PDF). You can also add 
contents and headings. This may be suitable for “blind” users. 

• If you're okay with the content as it stands (correct reading order, no 
spelling mistakes) then click Save as. Make sure it is at least PDF version 
1.4. Do not optimize for size. Do not show background image layers. 

If you want the output to look exactly like the original, save it as a Claro 
PDF. This is the only way to make sure the output looks exactly like the 
original scanned PDF or book, which is very helpful for “dyslexic” users. 

If you want the output to be able to be reflowed and zoomed and don't 
mind about it looking identical to the original, save it as PDF Edited or 
even Text. This is useful for “blind” users. 

For PDF output, accessibility information, or “tags”, are added here. 

8. Read back with ClaroRead (using Adobe Reader, Microsoft Word, or 
ClaroRead’s Save button) or distribute the accessible file to others. Keep 
the file safe so you don't have to go through the preparation process again. 
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ClaroRead Settings 
Click the Settings button to open ClaroRead’s Settings window. This 
button is always present on the ClaroRead toolbar. 

The Settings window has five tabs: 

 

• Speech tab – controls how ClaroRead reads out text, including which voice 
to use and how quickly it speaks. You can also choose which speech 
features are available. 

• View tab – controls how the ClaroRead toolbar looks and behaves, as well 
as which buttons appear on it. 

• Prediction tab – controls the behaviour of ClaroRead’s word prediction. 

• Check tab – settings for the Check window, which is used by ClaroRead’s 
spelling and homophone checkers, as well as the dictionary tooltip. 

• Scan tab – settings for ClaroRead’s scanning process. 
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Language list 

Depending on your system language, you may have a Language dropdown list 
at the bottom of the Settings window. Select a language for ClaroRead to use 
when speaking text, checking spelling, and so on. 

See Language Selection. 

About button 

Click the About button, at the bottom left of the Settings window, to open the 
About ClaroRead window. This shows the exact version of ClaroRead that you 
are using, your system language, and your licence key. 

Below the licence key is a Delete licence key button, which you can use to 
deactivate ClaroRead. 

See Deactivating ClaroRead. 

At the bottom of the About ClaroRead window is an Analytics checkbox. Clear 
this if you don’t want to send us anonymous usage statistics.  

Advanced Settings Editor 

ClaroRead’s Advanced Settings Editor contains additional configuration options 
including word lists for the spelling, homophone, and word prediction features. 
It can be accessed through the Extras button on the ClaroRead toolbar. 

See Advanced Settings Editor. 
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Speech Settings 
The Speech tab controls how ClaroRead sounds when it is reading out text. It 
also contains checkboxes that control basic speech behaviour and buttons to 
access further features and settings. 

 

Voice 

The Voice dropdown list contains all the voices available on your system: 

 

ClaroRead uses the selected voice for speaking text. It is important that you 
select a voice that matches the language of your text – an English voice like 
Vocalizer Kate will not read Swedish text correctly, for example. 

ClaroRead is supplied with a range of high-quality voices for each supported 
language, but it will also work with other SAPI5 voices installed on your 
computer. This includes Microsoft system voices such as David and Hazel. 

To install more voices, you can either select the Get more voices option, at the 
bottom of the list, or click the Speech tab’s Get more voices button. 
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Speed and Volume 

The Speed and Volume sliders control the speed and volume of the selected 
voice. Slide them left (slower/quieter) or right (faster/louder). 

 

 

Test 

Click the Test button to speak a sample of text using your selected 
voice, speed, and volume. Note that it can take a few seconds to load 
a new voice.  

Pronounce 

Click the Pronounce button to open ClaroRead’s pronunciation list for 
the current voice. If the selected voice does not pronounce something 
correctly, such as a name or a place, you can add a correction for it. 

See Adding a Word Pronunciation. 
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Get more voices 

Click the Get more voices button to install more voices for ClaroRead. 

The Claro Voice Setup window appears, containing a list of all available 
voices. Select the checkboxes next to any voices that you want to 
install, and then click Install to add them to your system. 

It may take some time to download and install the new voices. If your new 
voices do not appear in the Voice dropdown list, wait a few minutes and then 
restart ClaroRead. 

Note: While the Claro Voice Setup window includes a list of already installed 
voices, you cannot use it to delete voices. Instead, you need to open your 
Windows settings, find each voice in the applications list (under Add or remove 
programs, for example), and uninstall it from there. 

Advanced Speech 

Click the Advanced Speech button to open the Advanced Speech 
settings window, which contains settings for auto-speak (that is, what 
ClaroRead speaks automatically while you are using your computer) 
and text highlighting. 

See Advanced Speech Settings. 

Pause between words 

 

Select this checkbox to make ClaroRead deliberately separate each word when 
speaking text. This makes hearing individual words easier.  

If the checkbox is not selected, speech will flow naturally – it will take account 
of punctuation, certain abbreviations and other text details. 
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Stop after sentence 

 

Select this checkbox to make ClaroRead read only one sentence at a time 
when you use “click and play”, that is, when you click the Play button while 
working in applications such as Microsoft Word and Adobe Acrobat.  

To read the next sentence, you will need to click Play again. 

Speak word on Ctrl + hover 

 

Clear this checkbox to disable the “speak on Ctrl+hover” speech feature. 

This speech feature is enabled by default – when you hold down the Ctrl key 
and hover the mouse pointer over any word on your screen, ClaroRead will 
read that word aloud. 

Skip references 

 

Clear this checkbox to force ClaroRead to read out all references. 

By default, ClaroRead skips anything that looks like a reference, such as journal 
details in parentheses. Note that it does not skip other text in parentheses, 
such as asides or extra information. 

References can easily break up the flow of text, making it difficult to focus on 
sentences as they are read aloud. Clear this checkbox if you find that 
ClaroRead is skipping important text or if you want to examine the references 
in your text. 
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Adding a Word Pronunciation 

There are times when a text-to-speech voice does not pronounce something 
quite as you like, for example names of people or places. To correct how a 
word or phrase is pronounced, you can add it to ClaroRead’s pronunciation list. 

To open the pronunciation list for the current voice, click  on the Speech 
settings tab. The Pronounce window appears: 

 

To add an entry to the list: 

1. Type the word or phrase that is being mispronounced in the Word to 
replace field. 

2. Select the Match whole words checkbox if you want to change the 
pronunciation of a word but not affect other words that start with the same 
letters. 

3. Type how you think the word or phrase should sound in the New 
pronunciation field. 

This could be very different to how the word is spelled. You can use dashes 
to break up syllables. 

4. Click the Test buttons to see how the current voice pronounces your 
entries. 
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5. If it does not sound right, edit the New pronunciation entry and try again. 

You may need several attempts before you are happy with the new 
pronunciation. 

6. When you are happy with the pronunciation, click Add/Replace to add it to 
the pronunciation list.  

Note: Each voice has its own way of pronouncing text. Selecting a voice that is 
close to your own voice or region will result in better pronunciation. ClaroRead 
maintains separate pronunciation lists for each language – for example, a 
Swedish voice will need a very different list to an English voice. 

Match whole words only 

If you want to change the pronunciation of a word but not affect other words 
that start with the same letters, select the Match whole words only checkbox.  

For example, if your name is “Alis” and you want it to be pronounced as “Alley” 
but you do not want “Alison” to become “Alley-on”, select this checkbox before 
you click Add/Replace. 

Words with this checkbox selected are shown with a * in the pronunciation list. 
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Advanced Speech Settings 
The Advanced Speech settings control the amount and type of speech from 
ClaroRead, as well as how text is highlighted in applications such as Microsoft 
Word and Adobe Acrobat. 

To open the Advanced Speech settings, click  on the Speech settings 
tab. 

 

The Advanced Speech settings are divided into two sections: 

• Auto-speak – these settings control some of ClaroRead’s speech features. 

• Highlight – these settings control how ClaroRead highlights text. 

When you have finished editing Advanced Speech settings, you can either click 
Back to return to the main Settings window, or click OK to close the Settings 
window completely. 
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Auto-speak Settings 

The checkboxes on the left side of the Advanced Speech settings control some 
of ClaroRead’s speech features: 

 

Speak when mouse selects 

Select this checkbox to enable the “speak when mouse selects” speech feature 
– ClaroRead will read out any text you select with your mouse. This works in 
most applications and is often the most convenient way to speak text. 

Speak Under Mouse 

Select these checkboxes to enable the “speak under mouse” speech feature – 
ClaroRead will read out any text you hover your mouse pointer over, including 
tooltips, button names, and menu items. 

By default, the Some checkbox is selected – “speak under mouse” is enabled 
for a small selection of applications including ClaroIdeas. 

Select the All checkbox to enable “speak under mouse” for all applications, 
which makes almost all on-screen text accessible. Note that this can result in a 
lot of speech, which may be confusing or distracting. 
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Characters / Words / Sentences 

Select these checkboxes to enable the “echo text as you type” speech feature 
for characters, words, or sentences. When selected, ClaroRead will: 

• Speak back each character (letter or key) after it is typed. 

• Speak back each word after it is typed. 

• Speak back each sentence after it is typed. 

This is very useful for checking spelling and grammar during text creation and 
for reviewing sentences as they are created. 

Cursor moves 

Select this checkbox to enable the “speak when the cursor moves” speech 
feature – ClaroRead will read out characters, words, lines, or paragraphs as you 
press the arrow keys to move through text: 

• Pressing Right or Left moves the cursor to the next or previous character 
and ClaroRead reads out that character. 

• Pressing Ctrl+Right or Ctrl+Left moves the cursor to the next or previous 
word and ClaroRead reads out that word. 

• Pressing Down or Up moves the cursor to the next or previous line and 
ClaroRead reads out that entire line. 

• Pressing Ctrl+Down or Ctrl+Up moves the cursor to the next or previous 
paragraph and ClaroRead reads out that whole paragraph. 

You can use these commands repeatedly, for example pressing the Down 
arrow repeatedly to read through a document. 

You can configure ClaroRead to speak phonetic letter sounds rather than 
characters when you press the Right and Left arrow keys. See Letter sounds. 
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Echo Dragon voice input 

Select this checkbox to enable the “echo Dragon voice input” speech feature. If 
you use Nuance’s Dragon speech recognition software, ClaroRead echoes back 
each word, phrase, or command that Dragon recognises. This gives you 
confidence that Dragon has correctly recognised what you said, or draws your 
attention to any misrecognitions. 

See Echoing Dragon Voice Input. 

Letter sounds 

Select this checkbox to make ClaroRead speak phonemes, that is, phonetic 
letter sounds, for each character you type instead of its letter name. For 
example, when you type “a”, ClaroRead will say “ah” instead of “ay”. Depending 
on your language, you may be able to select male or female phonemes. 

This checkbox is only available if the Characters checkbox is selected. Note 
that phonemes are only available for certain languages, and sometimes only in 
a single gender.  
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Highlight Settings 

The option buttons and checkboxes on the right side of the Advanced Speech 
settings control how ClaroRead highlights text: 

 

ClaroRead highlights text when you use “click and play”, that is, when you click 
Play while working in applications such as Microsoft Word and Adobe Acrobat. 
ClaroRead’s voice is synchronised with the highlight, giving you greater 
assistance in following the text. 

None 

Select this option to disable highlighting – as ClaroRead speaks text, the words 
it speaks will not be highlighted. 

All the other highlight settings will be greyed out. 

Word 

Select this option to highlight only the word that is being spoken aloud: 
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Word trail 

Select this option to highlight words as they are spoken, leaving the previously 
spoken words highlighted. ClaroRead gradually highlights whole sentences, 
word by word: 

 

Some users find the Word highlight option distracting, with a flickering effect 
as individual words are highlighted. The Word trail option reduces this effect. 

Sentence 

Select this option to highlight the entire sentence that is being read out: 

 

 

This is the default setting. 

Paragraph 

Select this option to highlight the entire paragraph that is being read out: 
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Foreground 

Click this button to select the foreground colour used to highlight text as it is 
read out: 

 

The text itself will be changed to the selected colour as it is read out. 

If none of the standard colours is suitable, click Select another colour to select 
from all available system colours. 

The Text marker, in between the Foreground and Background buttons, gives 
you a preview of the selected colours. 

Background 

This button is only available if the No background checkbox is not selected. 

Click this button to select the background colour used to highlight text as it is 
read out: 

 

A coloured background will be applied to text as it is read out. 

The Text marker, in between the Foreground and Background buttons, gives 
you a preview of the selected colours. 
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No background 

Select this checkbox to disable background highlighting. The Background 
button will be greyed out. 

Focus sentence 

Select this checkbox to grey out the rest of your document while text is being 
spoken aloud: 

 

This option helps you to focus on the text that is being read out. It can be used 
with the Word, Word trail, Sentence, or Paragraph highlight options. 
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View Settings 
The View tab controls how the ClaroRead toolbar looks and behaves, as well as 
which buttons appear on it. 

 

Buttons 

The right side of the View tab controls the buttons that are shown on the 
ClaroRead toolbar: 

• To add a button to the toolbar, click it so that it appears with a blue 
highlight. 

• To remove a button from the toolbar, click it so that it appears in grey. 

In the above screenshot, for example, the Play, Check, and Help buttons will be 
shown on the toolbar, but the Font and Predict buttons will be hidden. 

Note that the Font button also controls the Spacing button – they can only be 
shown (or hidden) as a pair. 
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Toolbar 

The left side of the View tab controls how the ClaroRead toolbar looks and 
behaves. 

Small / Medium / Large 

Select an option to set the size of the toolbar. 

Show captions 

Clear this checkbox to remove the text below each button. Removing captions 
makes the toolbar more compact, but harder to use for beginners. 

Lock toolbar to active window 

Select this checkbox to lock the toolbar to the currently active window. The 
toolbar will move automatically as you switch between different applications, 
always locked to the top right of the active application's window. 

See Moving, Docking, and Hiding the ClaroRead Toolbar. 
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Skin options 

The option buttons at the bottom of the Toolbar section enable you to choose 
between three display styles or skins:  

Classic (default) – a friendly and high-colour skin for maximum usability. 

 

Professional – this skin uses colour to help you distinguish between the 
different buttons. 

 

Modern – this is a clear and simple skin designed to avoid distracting you 
from other applications. 

 

Dark mode 

While there is no option in the View settings to use a light-on-dark theme, 
ClaroRead follows your Windows settings – if you use a dark theme, or specify 
dark mode for your apps, ClaroRead automatically uses a dark version of your 
chosen skin. For example: 
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Prediction Settings 
The Prediction tab controls ClaroRead’s word prediction. You can enable or 
disable word prediction, select a dictionary, and customise word prediction 
behaviour to suit the way you work. 

 

The Prediction tab is divided into three sections: 

• Prediction – these settings control the word prediction style and dictionary. 

• Learn Prediction – these settings control how ClaroRead learns from you as 
you use word prediction. 

• Prediction List – these settings control how and when predicted words are 
displayed. 
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Use prediction 

 

This checkbox controls whether word prediction is on or off, and corresponds 
to the status of the Prediction button on the ClaroRead toolbar.  

If this checkbox is not selected, all options on the Prediction tab are disabled. 

Prediction Style and Dictionary 

These settings, at the top left of the Prediction tab, control the word prediction 
style and dictionary: 

 

Prediction style 

Select a prediction style from the list. There are four prediction styles to 
choose from: 

• Completion (c > cat) 

This is a conventional word prediction style, which predicts words based on 
exactly what you type.  

For example, if you type the letter “c”, words like cat and celery might 
appear in the Prediction List. 
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• Phonetic (k > cat) 

This is the default style, and predicts words based on how they sound 
rather than how they are spelled. 

For example, if you type the letter “k”, words that might appear include cat, 
competition, and cow, all of which start with a “k” sound, despite being 
spelled with a “c”. 

This style is good for people who can spell phonetically but are not good 
with irregular spellings. 

• First and Contains (gdt > graduate) 

This style matches the first letter you type, and then the ones after it in 
order, anywhere in the word. 

For example, if you type the letters “gdt”, words that might appear include 
graduate, grandfather, and goodnight. 

This style is good for people who usually get the first letter right but are not 
sure what comes afterwards, although they can usually guess or remember 
some more letters.  

• Contains Anywhere (ptg > sporting) 

This style matches the letters you type anywhere in a word, in any order.  

For example, if you type the letters “ptg”, words that might appear include 
sporting, copyright, stopping, and photographs. 

This style is especially helpful for people who really struggle with spelling, 
bringing up the most suggestions and the widest range of matches. 
However, as it brings up so many suggestions, it is best used with a small 
prediction dictionary. 

Note that you can also change prediction style from the Prediction List’s right 
mouse button menu. 
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Prediction dictionary 

Select a prediction dictionary from the list. The dictionaries available depend 
on the language that you are using, but may include: 

• Basic dictionary 

This is the standard dictionary for each language, containing a large number 
of words.  

• Simplified dictionaries 

These contain only the most common words, and are intended for use 
instead of the basic dictionary. They can be used with the Contains 
Anywhere prediction style, for example, to narrow down the prediction 
range. 

For example, ClaroRead includes 2000-word and 5000-word English 
dictionaries. 

• Subject-specific dictionaries 

These contain words specific to a particular subject, and are useful if you 
are normally quite good at spelling but are writing something on a subject 
that has a specialised vocabulary with complicated words. 

For example, ClaroRead’s subject-specific English dictionaries include 
Archaeology, Biology, and Nursing. The Biology dictionary includes words 
and phrases such as amoeba, DNA sequencing, and ventricle. 

You can edit ClaroRead’s prediction dictionaries, or even create new 
dictionaries, using the Advanced Settings Editor’s Training Prediction tab. For 
example, you could create a new dictionary containing words specific to your 
industry. 

See Advanced Settings Editor. 
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Include basic dictionary 

Select this checkbox to include the basic dictionary in addition to the selected 
prediction dictionary. 

Words from the selected prediction dictionary will appear nearer the top of the 
Prediction List. For example, if you select the Biology dictionary but choose to 
include the basic dictionary as well, biology-related words will tend to appear 
before standard words. 

Show ignored words 

Select this checkbox to keep showing “ignored” words within the Prediction List.  

For example, consider a scenario where you have typed “ca” and the Prediction 
List includes cathode, cattle, and catastrophe. What happens when you type 
the next letter depends on whether you have this setting enabled: 

• Show ignored words cleared 
All previously displayed words are ignored, as you have already rejected 
them. The Prediction List will no longer include the above words, even if you 
type “t” as the next letter. 

• Show ignored words selected 
Previously displayed words remain available, as long as they still apply for 
the letters you have typed. If you type “t” as the next letter, all the above 
words will still be displayed. 

Predict next word 

Clear this checkbox to disable “next word” prediction: 

• Predict next word selected 
ClaroRead suggests the next word when you press the Spacebar or select 
a word from the Prediction List. 

• Predict next word cleared 
The Prediction List will not be displayed until you have started typing the 
next word.  
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Learn Prediction Settings 

These settings, at the bottom left of the Prediction tab, control how ClaroRead 
adapts the selected prediction dictionary, that is, how it learns from you as you 
use word prediction: 

 

In addition to these settings, the Advanced Settings Editor’s Training Prediction 
tab enables you to train ClaroRead’s word prediction using your own Microsoft 
Word documents. 

See Advanced Settings Editor. 

Automatically add new words 

Automatically adds new words to the prediction dictionary based on the words 
that you type. 

If this setting is enabled, we recommend that you also enable Spell check 
before adding new words. 

Spell check before adding new words 

Checks the spelling of words before adding them to the prediction dictionary.  

This prevents typing errors being added to the dictionary. 

Learn word order 

When you select a “next word” prediction, ClaroRead remembers your selection 
and words you select often will move up the Prediction List. 
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Sort frequency 

Every time you finish a word, ClaroRead increases the likelihood that it will be 
shown higher in the Prediction List next time. 

Save dictionary when exiting 

If enabled, updates to the prediction dictionary will be saved when you close 
ClaroRead. 

This is disabled by default, so you do not accidentally add words you do not 
want into the dictionary. 

Prediction List Settings 

These settings, at the right side of the Prediction tab, control how and when 
predicted words are displayed: 

 

Show pictures 

Where available, show pictures in the Prediction List to help you choose words 
quickly. 
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Window follows cursor 

Rather than the Prediction List appearing at a fixed position on your screen, it 
will appear just below your cursor, in any application that you use. 

You can also change this setting from the Prediction List’s right mouse button 
menu. 

List words 

Select whether you want the words displayed in the Prediction List to be 
ordered alphabetically or in order of likelihood. 

Note that only the currently displayed words will be sorted alphabetically – the 
overall Prediction List remains ordered by likelihood. 

Predict after letters 

Sets the number of letters you must type before ClaroRead shows the 
Prediction List. 

Increasing this value reduces the activity of the Prediction List and makes it 
less disruptive. 

Prediction entries 

Sets the number of words that are shown in the Prediction List. 

While increasing this value makes it more likely that you will see the word you 
want, it can make the Prediction List more confusing. 

Minimum word length 

Sets how long a word must be before it appears in the Prediction List. 

If you can usually spell common short words like and, the, and are, but have 
problems with longer words, increase this value so that the Prediction List only 
contains longer, more difficult words. 
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Font, Background, and Foreground buttons 

Set the font for the Prediction List (including its style and size), as well as its 
background and foreground colours. 

You may want to use large fonts in the Prediction List so that you can select 
words more easily, or change its background colour so that it stands out from 
your applications.  

The area next to these buttons shows a preview of how the Prediction List will 
look.  
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Check Settings 
The Check tab contains settings for the Check window (which is used by 
ClaroRead’s spelling and homophone checkers) and dictionary tooltip. 

 

In addition to the settings on the Check tab, you can customise ClaroRead’s list 
of spelling corrections using the Advanced Settings Editor’s Spelling tab. For 
example, if you commonly misspell a particular word, you can add it to the list 
so that it appears as a suggestion in ClaroRead’s Check window. 

See Advanced Settings Editor. 
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Check Window Settings 

The checkboxes on the left side of the Check tab control what is shown in the 
Check window. They are all enabled by default – clear a checkbox to disable 
the corresponding feature. This section also includes the Homophones 
Settings button. 

Show spell checker 

Controls whether the Spelling tab is shown. 

Show meanings 

Controls whether the Meanings tab is shown. 

Show part of speech 

Controls whether parts of speech (that is, whether a word is a verb, noun, 
adjective, etc.) are shown in the Meanings tab. 

Show syllabification 

Controls whether the syllabification of words is shown at the bottom of the 
Check window. 

Show pictures 

Controls whether pictures are shown. 

Show phonetics 

Controls dynamic phonetic suggestions. These are advanced suggestions 
based on letter sounds, like “bizarre” for “bzr”. 

Homophone Settings button 

Opens ClaroRead’s homophone settings. 

See Homophones Settings. 



 

  133 

Dictionary Tooltip Settings 

The checkboxes on the right side of the Check tab control the dictionary 
tooltip’s behaviour. 

Use dictionary tooltip 

Clear this checkbox to turn off dictionary tooltips. 

Tooltip follows cursor 

By default, the dictionary tooltip stays in one place. You can move it where you 
want on your screen, so you know where to look when you need it. 

If you prefer the tooltip to move with your cursor, select this checkbox. 
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Homophones Settings 

The Homophones settings enable you to ignore certain homophones, or to 
disable the Check window’s Homophones tab entirely. 

To open the Homophones settings, click Homophone Settings on the Check 
settings tab. 

 

When you have finished editing homophones settings, you can either click 
Back to return to the main Settings window, or click OK to close both Settings 
windows. 

Exclude list 

This list contains all the homophones that will be identified by ClaroRead. To 
ignore a homophone, for example because you rarely get it wrong, select its 
checkbox. The word will no longer appear as a homophone. 

Note that you can edit ClaroRead’s master homophones list in the Advanced 
Settings Editor’s Homophones tab. You can add new alternatives or even whole 
new homophone pairs (or triplets, etc.). 

See Advanced Settings Editor. 
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Show homophones 

Clear this checkbox to disable the Check window’s Homophones tab. The 
Homophones tab will not be shown in the Check window, even when you run a 
homophone check. While homophones that are obviously being used 
incorrectly will still be shown in the Spelling tab, any other homophones will not 
be highlighted. 

Highlight Colour 

Click this button to select the text colour used to highlight homophones in 
Word: 

 

When you use the Show Homophones feature, any homophones identified in 
your Word document will be changed to the selected colour. 

If none of the standard colours is suitable, click Select another colour to select 
from all available system colours. 
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Scan Settings 
The Scan tab controls ClaroRead’s scanning process. You can control 
formatting, scanning language, and whether to use the Preview and Proofing 
windows. You can also set up new scanners using the Scanner Setup wizard. 

 

Format 

Select whether you want to keep a scanned document’s original format, or 
simplify it into a single text column.  

You can also choose whether to include images from the original document or 
discard them. 

Language for scanning 

Select a language to use for OCR. ClaroRead tries to recognise text in that 
language. 

For example, if you are going to scan a document in French, select French. 
Otherwise, ClaroRead will not know that it is looking for French words and 
phrases. 
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Preview scanned image 

Clear this checkbox to prevent the Preview window appearing after you have 
scanned a paper document or a file. 

The Preview window shows you a preview of the scanned document and gives 
you options for setting reading order and removing parts of the document that 
you do not want to scan. It also enables you to choose whether you want to 
send the scanned document directly to Word or to save it to file, either as a 
PDF or to another format. 

See Preview Window. 

Proofread before converting to text 

Select this checkbox to show the Proofing window after you have scanned a 
paper document or file. 

The Proofing window appears after the Preview window, and enables you to 
edit the scanned document before you save it. You can check and correct 
spelling, edit text (both content and formatting), redact or highlight text, and so 
on. 

See Proofing Window. 

Advanced save options 

Select this checkbox to show advanced options when you click the Preview or 
Proofing window’s Save as button. 

Instead of a standard Windows Save As window, ClaroRead will open its own 
Save to File window, which enables you to save your scanned document to 
many more file types – including Word, PDF, plain text, ePub, and Kindle. 

Each file type has its own options, giving you much more control over your 
output file. 
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View result 

Select this checkbox to automatically open output files after scanning. Files will 
open in their default applications, for example PDFs will usually open in Adobe 
Acrobat. 

Run Scanner Setup Wizard button 

Click this button to run the Scanner Setup wizard, which configures ClaroRead 
to connect to your scanner. 

Follow the instructions in the wizard to select the scanner that you want to use 
with ClaroRead’s “Scan from Paper” feature, or to set up additional scanners. 

See Scanner Setup Wizard. 

Reset button 

Click this button to reset ClaroRead’s scanner configuration. Any scanners you 
have set up using the Scanner Setup wizard are deleted immediately.  
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Scanner Setup Wizard 

Before you can use a scanner with ClaroRead, you need to set it up using the 
Scanner Setup wizard. The wizard runs automatically if you click Scan from 
Paper and have no scanners set up. Otherwise, you can run it from ClaroRead’s 
Scan settings. 

The first page of the Scanner Setup wizard shows the currently selected 
scanner and prompts you to download the latest scanner database from 
Nuance: 

 

ClaroRead uses its own scanner database, so select No and then click Next. 
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The second page of the wizard prompts you to choose an action. If you have 
no scanners set up, the only option is to select and test a new scanner: 

 

Select an option and click Next. 

If you have no scanners set up, a Select Scanner dialog box appears, 
prompting you to select from the list of available scanners: 

 

The list contains all scanners and digital cameras that have been set up on 
your computer. Generally, if there are multiple entries for a particular device, 
select the TWAIN version. 
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The list also contains a File: Pictures entry, which enables you to use the Scan 
from Paper option to process scanned image files rather than attempt to 
control your scanner directly – use this option if you have a shared scanner 
that scans to a network folder, for instance. 

Select a scanner or digital camera (or File: Pictures) and click OK. 

The next page of the wizard lists the scanners that are set up for use with 
ClaroRead: 

 

If you are setting up your first scanner, it will be shown with a “+” icon, 
indicating that the wizard will be adding it to the list. Click Next. 
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The next page of the wizard prompts you to select a mode and specify 
whether to perform tests: 

 

We recommend that you select Normal Mode. This will work with most 
scanners and bypass your scanner’s normal interface, if possible, making 
scanning quicker and simpler. 

If you cannot get a scanner working under Normal Mode, try again using Safe 
Mode. Under Safe Mode, ClaroRead will use your scanner’s normal interface. 

We recommend that you select the Perform Tests checkbox when using a 
scanner with ClaroRead for the first time. The wizard will then test the 
scanner’s connection and scanning abilities. 

After you have selected a mode and chosen whether or not to perform tests, 
click Next. 

Follow the instructions in the rest of the wizard to finish configuring and testing 
your scanner. 
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Language Selection 
ClaroRead uses the same language as Windows, that is, its button names and 
other on-screen text are shown in your Windows system language. 

Depending on your system language, you may see a Language dropdown list 
at the bottom of the Settings window: 

 

The list contains your system language (in this case, Swedish), as well as any 
second languages that are defined for it (in this case, UK English). 

ClaroRead will use the selected language for speaking text, checking spelling, 
and so on. 

You can specify different settings for each language in the list. For example, 
you can set Vocalizer Alva as the voice for Swedish, speaking quickly, while 
you use Vocalizer Daniel for English, set to speak slowly and loudly. 
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Tooltip Translations 

If you select a second language from the Language dropdown list (that is, a 
language other than your system language), ClaroRead’s dictionary tooltip will 
automatically translate selected words and phrases from your second language 
into your system language.  

See Tooltip Translations. 

Configuring Languages 

The Language dropdown list contains a preconfigured set of second 
languages for your system language. Some system languages have several 
languages available, while others have none. 

If your system language does not have any second languages defined, the 
Language dropdown list will not appear by default. To make it appear, you can 
add additional languages using ClaroRead’s Language utility. This is an 
executable, Language.exe, that you (or your administrator) can run from the 
Engine sub-folder of ClaroRead’s Program Files folder.  

You can select multiple languages in the Language utility. All the languages you 
select will appear in the Language dropdown list. 
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Advanced Settings Editor 

There is a similar Language dropdown list at the bottom of the Advanced 
Settings Editor: 

 

Again, some settings are specific to the language you select. For example, 
each language has its own homophones, prediction dictionaries, and spelling 
corrections. 
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Deactivating ClaroRead 
Deactivating ClaroRead enables you to transfer ClaroRead without using up 
one of your activations. When you start using a new computer, for instance. 

To deactivate ClaroRead, open the About ClaroRead window, click the Delete 
licence key button, and then follow the instructions in the Claro Software 
Unlicenser Wizard. 

The next time you run ClaroRead, you will be prompted for a valid licence key 
to reactivate your installation. You can also activate your installation by signing 
into your Claro Account, or you can run ClaroRead in demo mode for a limited 
time. 
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Advanced Settings Editor 
ClaroRead’s Advanced Settings Editor contains additional configuration options 
including spelling, homophone, and prediction functions. 

To open the Advanced Settings Editor, click the  button on the ClaroRead 
toolbar, and then select Advanced Settings Editor. 

The Advanced Settings Editor has four tabs: 

 

• General tab – contains options for the fonts that are shown in the Font 
button’s menu. You can also export and import ClaroRead’s settings, which 
helps you to move easily from one computer to another. 

• Homophones tab – shows ClaroRead’s homophones list. You can add new 
alternatives or even whole new homophone pairs (or triplets, etc.). 
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• Training Prediction tab – enables you to manage and edit ClaroRead’s 
prediction dictionaries. This tab also contains buttons for training 
ClaroRead’s word prediction using your Microsoft Word documents. 

• Spelling tab – shows ClaroRead’s list of spelling corrections. You can add 
words that you commonly misspell to this list. This tab also shows a list of 
correction contenders, that is, corrections that you have made using the 
Check window – you can choose to promote contenders to the main 
corrections list, or discard them. 

General Tab 
The Advanced Settings Editor’s General tab contains options for fonts and 
speech, as well as buttons to export and import ClaroRead’s settings and to 
check for updates. 
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Fonts and Background 

This section controls the fonts that are available when you click the ClaroRead 
toolbar’s Font button. Select your preferred fonts from the three dropdown 
lists. 

Note that the Reset background colour when exiting checkbox is not used by 
the current version of ClaroRead. 

Settings 

The Export and Import buttons enable you to backup and restore your 
ClaroRead settings, for example if you are moving to a new computer. All 
settings are exported to a single .zip file, including prediction dictionaries, 
spelling corrections, word pronunciations, and so on. 

Program 

Click the Check for updates button to launch Claro’s update program. This 
shows you if any Claro programs have new updates available. 
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Homophones Tab 
The Advanced Settings Editor’s Homophones tab enables you to view, add, 
edit and delete entries in ClaroRead’s list of homophones and tricky words.  

 

To view a homophone, simply click its entry in the list on the left side of the 
Homophones tab. Details will be displayed on the right. 

To edit an entry, select it from the list and click the Edit button. The Edit Entry 
window appears: 
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Change any details you wish and click OK. 

To add an entry, click the Add button on the Homophones tab, enter details in 
the Add Entry window, and then click OK.  

To delete an entry, select it from the list on the Homophones tab, and then 
click the Delete button. 

Training Prediction Tab 
The Training Prediction tab enables you to manage and edit prediction 
dictionaries, as well as training ClaroRead’s word prediction using your 
Microsoft Word documents. 
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Prediction Dictionary 

Select a dictionary from the Prediction Dictionary list. ClaroRead loads the 
dictionary and updates the Prediction Word List. 

 

You can manage your dictionaries using the buttons in the Prediction 
Dictionary section: 

• New – create a new dictionary based on the currently selected dictionary. 
To create an entirely new dictionary, first select Empty dictionary from the 
Prediction Dictionary list. 

• Rename – rename the selected dictionary. 

• Delete – delete the selected dictionary. 

Prediction Word List 

This list, at the left side of the Training Prediction tab, shows all words in the 
selected dictionary. 

 

You can double-click a word to edit it, or use the buttons in this section to add 
or remove words. If you hold down Ctrl and click the Remove button, 
ClaroRead removes all words from the selected dictionary. 

You can also export the entire prediction dictionary, with or without frequency 
data, or import an entire word list from file. ClaroRead uses a tab-delimited 
Unicode .csv format for dictionary files. 
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Train prediction dictionary using current Word doc 

This section, at the right side of the Training Prediction tab, enables you to 
train the currently selected dictionary from a Word document. 

 

Click the buttons in this section to learn new words, word frequency, or word 
order by analysing the currently open Word document. The analysis happens 
immediately, so make sure that you have selected the correct dictionary, and 
have the correct Word document open. 

Note that analysing a long Word document is processor-intensive and can take 
a long time. ClaroRead displays a progress bar below the three Learn buttons. 

We recommend that you leave the Spellcheck before adding checkbox 
selected, so that only words that are spelled correctly are added to your 
dictionary. 

After a training action is complete, you can click the Report button to view its 
details, for example the new words that have been added to your dictionary. 
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Spelling Tab 
The Advanced Settings Editor’s Spelling tab shows ClaroRead’s list of spelling 
corrections, as well as the “contenders” that it has learned from you. 

 

Your spelling corrections 

This is ClaroRead’s list of spelling corrections, that is, the corrections that will 
be suggested first in the Check window. If ClaroRead’s spelling checker finds 
an incorrect spelling that is in the Word column, it will look up the 
corresponding entry from the Correction column and put that at the top of the 
Check window’s Suggestions list. 

You can add or remove word pairs from the list using the New and Delete 
buttons. For example, if you often misspell “know” as “noh”, you should add 
“noh / know” to the list – when ClaroRead’s spelling checker comes across the 
word “noh”, the suggestion “know” will be at the top of its list. 

Click the AutoCorrect button to add all your spelling corrections to Microsoft 
Word’s AutoCorrect list – when you type “noh”, for example, Word will correct it 
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to “know” automatically. The correction words are also added to Word as a 
custom dictionary, so that they will be recognised by Word’s own spelling 
checker. 

Note that clicking AutoCorrect modifies Word’s AutoCorrect list and custom 
dictionary immediately. You must close Word before you can use this feature. 

Contenders 

When you make spelling corrections using the Check window, ClaroRead 
records them for you to use later. These corrections are recorded as word-
correction pairs in the Contenders section of the Spelling tab. 

Click the Transfer button to move the selected word pair from the Contenders 
list to the “Your spelling corrections” list. That word pair will then be recognised 
by ClaroRead’s spelling checker and used in the Check window. 

Click the Delete button to remove the selected word pair from the Contenders 
list, for example if it was a one-off correction that you are unlikely to use again. 
Clicking Delete All removes all the pairs from the list. 

Click the Report button to see a printable and sortable report of all your 
spelling corrections, including the ones that you have deleted from the 
Contenders list. The report includes when you last made each correction, how 
you used it, and how often you have used it. 
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We recommend that you check the Contenders list regularly and transfer any 
word pairs that you think you will use again. This will make ClaroRead’s spelling 
checker work better for you. 

If you do not want ClaroRead to record your spelling corrections, clear the 
Collect spelling data checkbox. 
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